
SPRACOVANIE A VIZUALIZÁCIA
EXPERIMENTÁLNYCH DÁT

Ladislav Ševčovič



Vydané v rámci projektu RVEDOK „Rozšírenie vzdelávania doktorandov v zmysle kritérií systému
kvality na Technickej univerzite v Košiciachÿ. Tento projekt je spolufinacovaný Európskou Úniou.

V práci sú použité názvy programových produktov, firiem a pod., ktoré môžu byť ochrannými
známkami alebo registrovanými ochrannými známkami príslušných vlastníkov.

Sadzba programom pdfTEX

Copyright c© 2008 Ladislav Ševčovič

Ktokoľvek má dovolenie vyhotoviť alebo distribuovať doslovný opis tohoto dokumentu alebo jeho
časti akýmkoľvek médiom za predpokladu, že bude zachované oznámenie o copyrighte a oznámenie
o povolení, a že distribútor príjemcovi poskytne povolenie na ďalšie šírenie, a to v rovnakej podobe,
akú má toto oznámenie.



Obsah
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Primárnym ciel’om výskumu
nesmie byt’ viac faktorov, ale viac
faktov so strategickou hodnotou.

PAUL WEISS

Úvod

Pri spracovanı́ výsledkov meranı́ a pozorovanı́ sa široko použı́vajú metódy grafického zobrazenia.
Čı́selné údaje, ako výsledky meranı́ a pozorovanı́ prezentované v tabul’kovej forme neumožňujú do-
statočne názorne charakterizovat’ zákonitosti študovaných procesov, preto je vhodné tabul’ku doplnit’
grafom (graf je vlastne vizuálna podoba údajov v tabul’ke). Grafické znázornenie poskytuje názornejšiu
predstavu o výsledkoch experimentu, umožňuje lepšie pochopit’ fyzikálny zmysel študovaného pro-
cesu, zistit’ (odhalit’) všeobecný charakter funkčnej závislosti premenných veličı́n a napokon stanovit’
prı́tomnost’ (existenciu) maxı́m alebo minı́m funkčnej závislosti.

Grafy taktiež umožňujú vel’mi názorne porovnávat’ experimentálne hodnoty s teoretickou krivkou
(závislost’ou). Z precı́zne vyhotoveného grafu nameranej závislosti dvoch veličı́n sa dajú s dostatoč-
nou presnost’ou určit’ napr. charakteristiky funkcie. Môžeme určit’ polohu už spomı́naných extrémov,
inflexných bodov, pri lineárnej závislosti odčı́tat’ z grafu smernicu krivky a pod. Na okraj spome-
nieme, že sú známe metódy na grafické derivovanie a kvadratúru (integrovanie). Výhoda grafických
metód sa uplatnı́ predovšetkým pri meraniach s neekvidištančnými hodnotami nezávisle premennej
veličiny, pretože čı́selné spracovanie výsledkov je pri takýchto meraniach zložitejšie (t’ažšie), ako pre
ekvidištančné merania, napriek tomu, grafické riešenie je vo všeobecnosti nepresnejšie. Spomı́nané
postupy a metódy však stratili na význame v súvislosti s rozvojom výpočtovej techniky a jej aplikáciı́
v experimentálnej praxi.

Na kreslenie grafov a ilustráciı́ existujú komerčné programy, ktoré sú bohato vybavené podprogramami
na interpoláciu aj extrapoláciu, na fitovanie (nájdenie najlepšej aproximácie) nameranej závislosti
zvolenou triedou funkciı́, na optimalizáciu, obsahujú štatistické spracovanie výsledkov, vyhladenie
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závislostı́, rôzne filtre a pod. V prostredı́ operačného systému GNU/Linux je bohatý výber programov
na spracovanie a analýzu dát, ktoré sú na rozdiel od komerčného OS Windows šı́rené pod licenciou GPL
(GNU General Public License)1. Vymenujme niektoré matematicko-grafické programy:

• GNUPLOT,

• Gnumeric a Calc z kancelárskeho balı́ka OpenOffice sú plnohodnotnou náhradou za komerčný
program Excel z MS Office, d’alej sú to

• Veusz,

• LabPlot,

• Grace (xmgrace),

• Scigraphica,

• Octave,

• PyLab,

• QtiPlot a napokon

• Kpl.

V tejto prı́ručke stručne opı́šeme použı́vanie posledných dvoch programov. Základom programovania
v prostredı́ programuPyLab a jeho použitiu na podobné účely je venovaná prı́ručka M. Kaukiča (2006)
a programu Octave prı́ručka J. Bušu (2006). Dôvody, ktoré viedli k tomuto výberu sú nasledujúce:

1. Proces inštalácie a konfigurácie je vel’mi jednoduchý a zvládne ho aj bežný použı́vatel’výpočtovej
techniky.

2. Oba programy majú prı́vetivé grafické prostredie, pod ktorým sa skrýva softvér profesionálnej
kvality.

3. Program QtiPlot je vydareným klonom populárneho komerčného programu OriginLabTM,
ktorým môžete vykonat’ profesionálnu analýzu experimentálnych dát, nakreslit’ do grafu zložité
funkcie. Grafický výstup je vysokej kvality vhodný na d’alšie spracovanie, napr. programom TEX.

4. Program Kpl je z pohl’adu pomeru jednoduchosti ovládania k výkonnosti ojedinelý vo svojej
kategórii. Môžeme ho dopĺňat’ vlastnými knižnicami na fitovanie dát a programovými skriptmi2

na vykresl’ovanie všakovakých funkciı́, ktoré sa napı́šu a skompilujú v programovacom jazyku C.

1Projekt GNU bol založený na vybudovanie kompletného operačného systému, ktorého výsledky budú vol’ne dostupné
počı́tačovej verejnosti. Programy dostupné v rámci GNU sú chránené tzv. GNU General Public License (GPL), ktorá na
rozdiel od všetkých ostatných licenciı́ garantuje každému právo programy slobodne použı́vat’a šı́rit’ d’alej.

2Skripty sú ASCII (textové) súbory obsahujúce prı́kazy. Sú tiež známe pod názvom zdrojové súbory (source
files) alebo dávkové súbory (batch files). Ked’ skript spustı́te, prı́kazy sa vykonajú (interpretujú) jeden za druhým
počnúc od začiatku tak, akoby ste ich pı́sali samostatne priamo v prı́kazovom riadku jeden za druhým. Ide
o akúsi obdobu dávkových prı́kazov v OS MS DOS.
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Vytvorené grafy môžeme exportovat’ do rôznych formátov, okrem iného do Encapsulated Post-
script (EPS).

5. Parametre fitovacı́ch (aproximačných) funkciı́, ktoré sme zı́skali po spracovanı́ referenčných dát
na testovanie matematických knižnı́c a algoritmov týmito programami sú v dobrej zhode s hod-
notami uverejnenými na internetovej stránke Národného inštitútu štandardov a technológiı́
Spojených štátov amerických (NIST, 2006).

Tématický materiál spracovaný v prı́ručke je usporiadaný do piatich kapitol, pričom každá sa sústre-
d’uje na jednu tému.

V prvej kapitole uvádzame krátky súpis hlavných pojmov z oblasti neistôt merania. Druhá kapitola,
ktorá je spoločná pre tretiu a štvrtú, je venovaná základným numerickým metódam na spracovanie
experimentálnych dát. Čitatel’ by v každom prı́pade mal vediet’, čo a ako počı́tačovým programom
analyzuje a aká je podstata metódy, ktorú použı́va. Pri prvom čı́tanı́ prı́ručky je možné túto kapitolu
preskočit’.

Tretia a štvrtá kapitola sú t’ažiskom prı́ručky, čitatel’sa z nich dozvie, aké možnosti jednotlivé programy
poskytujú a ako ich rýchlo použit’ na spracovanie a vizualizáciu nameraných dát, prı́padne zobrazenie
funkciı́.

V záverečnej piatej kapitole sa kratúčko venujeme základným pravidlám na tvorbu úhl’adného grafu.

Prı́ručka je určená všetkým, ktorı́ potrebujú rýchle zvládnut’ prácu s programom na spol’ahlivé nume-
rické spracovanie nameraných dát a ich kvalitnú grafickú prezentáciu do publikáciı́, vysokoškolských
kvalifikačných prác, konferenčných zbornı́kov, posterov a pod.

Ďakujem Jaroslavovi Skřivánkovi a Jánovi Bušovi za starostlivé prečı́tanie rukopisu a cenné prı́po-
mienky, ktoré prispeli k spresneniu niektorých formuláciı́ a ku skvalitneniu tejto prı́ručky.3

Košice 2008 L. Ševčovič

3Elektronická verzia prı́ručky, doplnky a opravy sú prı́stupné na URL adrese http: // people. tuke. sk/ ladislav.
sevcovic/ rvedok . Prı́pomienky a návrhy, ktoré pomôžu vylepšit’ d’alšie vydanie prı́ručky, zasielajte na adresu: RNDr. La-
dislav Ševčovič (Ladislav.Sevcovic@tuke.sk), Katedra fyziky, FEI, Technická univerzita v Košiciach, Park Komen-
ského 2, 041 20 Košice.

http://people.tuke.sk/ladislav.sevcovic/rvedok
http://people.tuke.sk/ladislav.sevcovic/rvedok
mailto:Ladislav.Sevcovic@tuke.sk


1 Základné pojmy a definı́cie z oblasti neistôt meranı́

V súčasnosti sa v metrológii, pri fyzikálnych a technických meraniach postupne prechádza
na nové metódy vyjadrovania odchýlok. Doterajšie chyby meranı́ sú v súlade s medzinárod-
nými predpismi ISO a IEC nahradzované neistotami meranı́. Za hlavný dokument je možné
považovat’predovšetkým smernicu, ktorá bola vydaná pod názvom Guide to Expression of the
Uncertainty of Measurement (GUM) (ISO, Switzerland 1995) medzinárodnými metrologickými
orgánmi v roku 1993, korigovaná a doplnená v roku 1995. Pre prı́rodovedcov bude iste zau-
jı́mavé navštı́vit’ WWW stránku Národného inštitútu štandardov a technológiı́ Spojených
štátov amerických (NIST, 2006) http://physics.nist.gov/cuu/Uncertainty/basic.html,
ktorá prináša základné informácie o neistotách a ich vyjadrovanı́.

Uvádzame zoznam niektorých významných medzinárodných organizáciı́, ktoré tento pro-
jekt podporujú:

• BIPM Bureau International des Poids et Mesures

• IEC International Electrotechnical Commission

• IFCC International Federation of Clinical Chemistry

• ISO International Organization for Standardization

• IUPAC International Union of Pure and Applied Chemistry

• IUPAP International Union of Pure and Applied Physics

• OIML International Organization of Legal Metrology

Aplikovanie a zavádzanie nových experimentálnych metód, prı́strojov a pracovných po-
stupov, práve tak, ako použı́vanie staršı́ch a osvedčených metód, by malo byt’ podložené
štúdiom ich vlastnostı́, aby ich neskoršie použı́vanie nenarážalo na nejasnosti pri interpre-
tácii výsledkov zı́skaných použitými postupmi a metódami.

Medzi základné problémy nepochybne patria otázky presnosti a správnosti, alebo skôr
nepresnosti a nesprávnosti meranı́. Definı́cia týchto dvoch pojmov je dost’ t’ažká, avšak
ich obsah je intuitı́vne celkom jasný. Správnost’ súvisı́ s tým, ako sa meranie (namerané
hodnoty) zhodujú so skutočnou meranou hodnotou, zatial’ čo presnost’ súvisı́ s tým, ako
sa opakované merania (namerané hodnoty) zhodujú medzi sebou. Môžeme teda hovorit’
o systematických chybách, ktoré sa prejavujú ako stály rozdiel medzi nameranými hodnotami
(alebo ich strednou hodnotou) a skutočnou (správnou)4 hodnotou a o náhodných chybách,
ktoré sa prejavujú vo variabilite nameraných hodnôt okolo ich strednej hodnoty. Uvádzajú
sa ešte hrubé chyby, ktoré vznikajú napr. poruchou prı́strojov, nepozornost’ou pracovnı́ka,
krátkodobou zmenou experimentálnych podmienok a pod.

Variabilita nameraných hodnôt má dve základné prı́činy, ktoré väčšinou pôsobia súčasne:

4Niektorı́ autori použı́vajú aj pomenovanie „pravá“ vo význame hodnoty zı́skanej naprosto presným mera-
nı́m (PALENČÁR A KOL., 2000).

http://physics.nist.gov/cuu/Uncertainty/basic.html
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ä vlastnosti vyšetrovaného javu (napr. neodstranitel’ná nehomogenita vyšetrovaného
materiálu, fluktuácie vyvolané fyzikálnymi procesmi a pod.)

ä a technické nedostatky meracej metódy (nepresnost’ meracieho zariadenia, nepresnost’
pri prı́prave vzoriek, zmeny prostredia, v ktorom meranie prebieha, t. j. teplota, vlhkost’
vzduchu a pod. a tiež vplyv osôb, ktorı́ sa experimentu, merania zúčastňujú).

Je potrebné teda pamätat’ na oba zdroje neistôt a snažit’ sa o udržanie čo najstabilnejšı́ch
podmienok na prevádzanie meranı́. V d’alšom nás budú zaujimat’ otázky súvisiace s pres-
nost’ou (opakovatel’nost’ou), budeme pritom predpokladat’, že metóda merania je správna,
t. j. že sa správna hodnota rovná strednej hodnote rozdelenia nameraných hodnôt. O náhod-
ných chybách sa spravidla predpokladá, že sú rozdelené normálne, tento predpoklad, ktorý
býva obvykle splnený aspoň približne budeme v d’alšom akceptovat’; vo všeobecnosti však
nemusı́ byt’ splnený.

Stručný slovnı́k pojmov

Aritmetický priemer je súčet hodnôt pozorovanı́
(meranı́, odčı́tanı́ a pod.) delený počtom hodnôt

xi = Xi =
1
n

n

∑
k=1

Xi,k. (1)

Citlivost’ meracieho prı́stroja je prakticky zmena
hodnoty meranej veličiny, ktorá korešponduje
s najmenšı́m dielikom stupnice. Pre čı́slicové me-
racie prı́stroje je to podiel počtu čı́slic zmeny
údaja a zmeny vstupnej veličiny, ktorá zmenu
vyvolala.

Disperzia (variancia) pozri Rozptyl.

Chyba, máme tu ma mysli chybu meracieho prı́-
stroja, ktorá má svoj pôvod v konštrukčnom
usporiadanı́, v konečnom delenı́ stupnice mera-
ných hodnôt a pod. Základnými zdrojmi chýb
sú:

ä nedokonalost’ meracı́ch prı́strojov,
ä stárnutie a opotrebenie meracı́ch prı́stro-

jov, čı́m sa môžu menit’ ich charakteristiky
a parametre,

ä chyby experimentátora,
ä nepresné metódy vyhodnocovania me-

ranı́,
ä vplyv linearizácie, interpolácie a zaokrúh-

l’ovania,

ä zlá kalibrácia, inštalácia alebo umiestnenie
prı́strojov atd’.

Chyba merania (odchýlka) je rozdiel medzi na-
meranou Xi a skutočnou hodnotou µ určujúcej
veličiny v tom istom okamihu. Pri meranı́ určitej
veličiny sa prevádza len konečný počet meranı́.
Predpokladajme, že bolo prevedené meranie ve-
ličiny X a zı́skané hodnoty X1, X2, . . . , Xn, kto-
rých chyby môžeme vyjadrit’ vzt’ahom

∆Xi = Xi − µ (2)

a majú normálne rozdelenie. Aritmetický prie-
mer nameraných hodnôt Xi podl’a (1) dáva
najpravdepodobnejšiu hodnotu meranej veli-
činy µ ≡ Xi.

Korelácia je kvantitatı́vna miera vzt’ahu medzi
dvoma veličinami vyjadrujeme ju ako

r(xi, xk) = ∑n
i=1(xi − xi)(xk − xk)√

∑n
i=1(xi − xi)2 ∑n

i=1(xk − xk)2

=
D(xi, xk)√

D(xi)
√

D(xk)
,

(3)

kde D(xi, xk) je kovariancia, D(xi) a D(xk) sú
disperzie, pričom −1 5 r(xi, xk) 5 1. Hod-
nota r(xi, xk) = 1 znamená, že ide o funkčnú
rastúcu závislost’, hodnota r(xi, xk) = −1 zna-
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mená funkčnú klesajúcu závislost’. Obidva prı́-
pady a prı́vlastok funkčný zodpovedajú situácii,
ked’ všetky body ležia na priamke. Ak sú skú-
mané veličiny nezávislé, bude r(xi, xk) = 0, ale
naopak nulový koeficient korelácie nemusı́ zna-
menat’ nezávislost’. Môže ı́st’ o (to byt’) zložitejšı́
vzt’ah, napr. závislost’, ktorá v jednej časti rastie
a v druhej klesá. Korelácia je štatistická (pravde-
podobnostná) závislost’ dvoch náhodných veli-
čı́n (premenných). Symbolom xi a xk sa tu nedáva
bežný význam nezávisle a závisle premennej,
pretože ani jednej z náhodných premenných ne-
prisudzujeme charakter prı́činy alebo následku.

Kovariancia (vzájomný rozptyl) je spoločná men-
livost’ daných dvoch vlastnostı́ a charakterizuje
väzbu hodnôt výberu

D(xi, xk) =
1

n− 1

n

∑
j=1

(xi,j − xi)(xk,j − xk). (4)

Meracı́ prı́stroj je zariadenie určené na prevod
meranej veličiny na signál nesúci informáciu o jej
hodnote (údaj). Charakterizujeme ho cilivost’ou,
schopnost’ou replikovat’ údaje, rozptylom, pres-
nost’ou, hustotou pravdepodobnosti chýb me-
ranı́ a pod. Priebeh registrácie môže byt’ spojitý,
ked’je registrácia čı́slicová potom má schodı́kový
tvar.

Náhodný výber rozsahu n je n-tica náhodných pre-
menných, ktoré sú stochasticky nezávislé a majú
rovnak rozdelenie pravdepodobnosti.

Neistota merania (skrátene neistota) je parame-
ter, ktorý súvisı́ s výsledkom merania a ktorý
určuje rozptyl hodnôt, ktoré môžeme ešte raci-
onálne priradit’ k meranej veličine. (Neistota je
teda interval, v ktorom sa s určitost’ou, defino-
vanou pravdepodobnost’ou bude skutočná hod-
nota nachádzat’.) Neistoty (z jednotlivych zdro-
jov) môžeme vyhodnocovat’ dvoma základnými
metódami:

ä štatistickými metódami z nameraných
údajov, ktoré sa nazývajú neistoty stanovené
metódou A, skrátene ich voláme neistoty
typu A a označujeme ich ako uA(xi),

ä neistoty zı́skané iným spôsobom ako
v predošlom prı́pade, ktoré sa nazývajú
neistoty stanovené metódou B, skrátene ich
voláme neistoty typu B a označujeme ich
ako uB(xi) (napr. výsledky zı́skané pri
predchádzajúcich meraniach, špecifikácie
od výrobcu meracieho prı́stroja, údaje
z certifikátov, kalibračných listov, neistoty
referenčných údajov a pod.).

Vhodným zlúčenı́m štandardných neistôt zo
všetkých zdrojov zı́skame celkovú (kombino-
vanú) štandardnú neistotu. Treba zdôraznit’, že
nečlenı́me neistoty, ale metódy ich vyhodnoco-
vania na metódu A a metódu B. Neistoty určené
oboma metódami sú rovnocenné, pokial’boli ur-
čené korektne.

Normálné (Gaussove) rozdelenie sa použı́va na ap-
roximáciu v prı́padoch, ked’ sa často vyskytujú
malé odchýlky od menovitej hodnoty, pričom
s rastúcou vel’kost’ou odchýlok pravdepodob-
nost’ ich výskytu klesá, napr. ked’ je zdrojom ne-
istoty meracı́ prı́stroj od spol’ahlivého výrobcu
(môžeme predpokladat’, že väčšina prı́strojov
bude zdrojom malých chýb).

Opakovatel’nost’ (replikovatel’nost’) je charakteris-
tika meracieho systému a znamená, že distri-
bučná funkcia chyby merania sa nemenı́ pri opa-
kovanı́ meranı́, teda akékol’vek súbory dát zı́s-
kané z nezávislých opakovaných meranı́ hod-
noty f nejakej veličiny je možné modelovat’ ako
realizáciu náhodných výberov z toho istého roz-
delenia pravdepodobnosti. Stálost’ distribučnej
funkcie je podmienkou replikovatel’nosti mera-
cieho systému. Meracı́ prı́stroj bez driftu musı́ pri
opakovanom meranı́ jednej a tej istej hodnoty vy-
kazovat’ vlastnost’, ktorá sa volá replikovatel’nost’.
Matematicky to znamená, že súbory nezávisle
nameraných dát sú realizáciou náhodného výberu
z toho istého rozdelenia pravdepodobnosti (KU-
BÁČEK A KUBÁČKOVÁ, 2000).

Presnost’ merania je miera nesúhlasu nameranej
a skutočnej hodnoty určujúcej veličiny.
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Reprodukovatel’nost’ merania je opakovatel’nost’
výsledkov merania prevedených za rovnakých
podmienok, ale v rôznych časových okamihoch.

Rovnomerné (pravouhlé) rozdelenie pravdepodob-
nosti sa použı́va v prı́padoch, ked’ pravdepo-
dobnost’ výskytu ktorejkol’vek odchýlky v ce-
lom intervale ±zjmax je rovnaká. V praxi sa po-
uživa najčastejšie, predovšetkým preto, že väč-
šinou nemáme k dispozı́cii dostatočné poznatky
o rozdelenı́ pravdepodobnosti výskytu odchý-
lok a teda nemáme dôvod dávat’ niektorým od-
chýlkam prednost’ tým, že použijeme iný typ
rozdelenia. Spojitá náhodná veličina X sa riadi
zákonom rovnomerného rozdelenia (má rovno-
merné rozdelenie), ked’ jej možné hodnoty ležia
(nachádzajú sa) v určených hraniciach, okrem
toho v hraniciach tohto intervalu sú všetky hod-
noty náhodnej veličiny rovnako pravdepodobné
(majú rovnakú hustotu pravdepodobnosti roz-
delenia). S náhodnou veličinou, ktorá má vlast-
nosti rovnomerného rozdelenia sa často stretá-
vame v meracej technike (praxi) pri zaokrúhl’o-
vanı́ údajov z meracı́ch prı́strojov na celý die-
lik delenia stupnice. Chyba pri zaokrúhl’ovanı́
údaja stupnice na najbližšı́ dielik delenia je ná-
hodná veličina Xi, ktorá môže nadobúdat’ l’u-
bovol’nú hodnotu medzi dvoma susednými die-
likmi stupnice s konštantnou hustotou pravde-
podobnosti. Ked’sa chyby podriad’ujú zákonu rovno-
merného rozdelenia počet prevedených meranı́ nemá
vplyv na stupeň hodnovernosti výsledku merania na
rozdiel od iných zákonov rozdelenia, napr. nor-
málneho, kde zvyšovanı́m počtu meranı́ a ich
spracovanı́m, môžeme podstatne zvýšit’ pres-
nost’odhadu meranej veličiny.

Rozdelenie pravdepodobnosti je funkcia vyjadru-
júca pravdepodobnost’, že meranie (náhodná ve-
ličina) nadobudne určitú hodnotu alebo hodnoty
z istého intervalu.

Rozptyl je stredná hodota druhej mocniny od-
chýlky náhodnej veličiny od jej strednej hodnoty

D(Xi) = s2(Xi) =
∑n

k=1(Xi,k − Xi)2

n− 1
. (5)

Rozptyl registrácie je definovaný disperziou (dru-
hým centrálnym momentom teoretickej distribú-
cie chýb merania daným prı́strojom). Niekedy
sa nazýva aj charkteristikou vnútornej presnosti.
Charakteristika vonkajšej presnosti pri danom po-
čte opakovaných meranı́ n konkrétnej hodnoty fi

je daná hodnotou veličiny

E
[
( f̂ − fi)2

]
=

s2

n
+ B2, (6)

kde B = E( f̂ )− fi, f̂ je uvažovaný odhad veli-
činy f , E[·] a E(·) vyjadrujú strednú hodnotu ve-
ličiny. Hodnota B sa nazýva vychýlenost’ (bias)
odhadu f̂ . Ked’prı́stroj (súbor dát zı́skaných prı́-
strojom) je charakterizovaný hustotou pravde-
podobnosti, pre ktorú platı́ E(Xi) = 0, potom sú
charakteristiky vonkajšej a vnútornej presnosti
zhodné. Rozptyl (disperzia) meracieho prı́stroja je
jeho dôležitou charakteristikou, avšak nevysti-
huje úplne štatistické správanie chýb. Lepšiou
charakteristikou správania chýb meranı́ je ich
rozdelenie pravdepodobnosti. Pri použitı́ me-
racieho prı́stroja vzniká problém, ako túto hus-
totu poznat’aspoň približne (KUBÁČEK A KUBÁČ-
KOVÁ, 2000).

Rozšı́rená neistota je veličina definujúca interval
okolo výsledku merania, ktorý zahrňuje vel’kú
čast’ rozdelenia pravdepodobnosti hodnôt, ktoré
je môžné priradit’ k meranej veličine.

Signál je fyzikálna veličina, ktorá je nositel’kou
pridanej namodulovanej informácie.

Smerodajná odchýlka je druhá odmocnina z rozp-
tylu prı́slušného rozdelenia pravdepodobnosti.

Štandardná neistota merania je neistota merania
vyjadrená ako smerodajná odchýlka. Pojem štan-
dardná neistota (v meranı́) a smerodajná odchýlka
(odmocnina z disperzie resp. z rozptylu; charak-
terizuje presnost’ merania) znamenajú to isté.

Trojuholnı́kové (Simpsonove) rozdelenie sa použı́va
na modelovanie situáciı́ (prı́padov), ktoré sa po-
dobajú normálnemu rozdeleniu.

Vstupný odhad je výsledok merania vypočı́taný
z odhadov vstupných dát pomocou funkcie mo-
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delu merania.

Výberová smerodajná odchýlka je druhá odmocnina
výberového rozptylu. Náhodnú chybu v klasic-
kej teórii chýb najčastejšie zastupuje smerodajná
odchýlka výberového súboru

s(Xi) =

√
∑n

k=1(Xi,k − Xi)2

n− 1
, (7)

zriedkavo smerodajná odchýlka aritmetického
priemeru

s(Xi) =
s(Xi)√

n
=

√
∑n

k=1(Xi,k − Xi)2

n(n− 1)
. (8)

Výberový rozptyl je veličina charakterizujúca rop-
týlenie výsledkov série n pozorovanı́ (meranı́,
odčı́tanı́ a pod.) rovnakej meranej veličiny, zı́s-
kaná ako druhá mocnina výberovej smerodajnej
odchýlky.

Výsledok merania je hodnota, ktorá prislúcha me-
ranej veličine a bola zı́skaná meranı́m. Ked’pou-
žijeme pomenovanie výsledok merania, musı́me
uviest’, či sa vzt’ahuje na:

ä údaj meradla (meracieho prı́stroja),
ä nekorigovaný výsledok,
ä korigovaný výsledok.

Nekorigovaný výsledok je taký výsledok merania,
pri ktorom nie sú uplatnené korekcie známych
systematických chýb. Korigovaný výsledok mera-
nia je výsledok po korekcii systematických chýb.
Výsledkom merania je často hodnota zı́skaná
výpočtom z výsledku viacerých opakovaných
meranı́.Vzhl’adom na to, že skutočnú hodnotu
meranej veličiny zist’ujeme procesom merania,
ktorý je zat’ažený rôznymi chybami, výsledok
merania je len odhadom (skutočnej) hodnoty me-
ranej veličiny. Pri udávanı́ výsledku merania je
preto dôležité stanovit’ aj kvalitu tohto odhadu,
ktorá sa definuje pomocou neistoty. Úplný údaj
výsledku obsahuje okrem výslednej hodnoty me-
ranej veličiny aj údaj o neistote merania. (WIM-
MER A KOL., 2001, str. 103)

Výstupná veličina je veličina, ktorá pri vyhodno-
tenı́ merania predstavuje meranú veličinu.

Typy neistôt

Ako sme to už spomenuli, je pojem neistota (ne-
istota merania) spojený s označenı́m parametera
súvisiaceho s výsledkom merania a charakte-
rizujúceho rozsah hodnôt, ktoré môžeme raci-
onálne priradit’ meranej veličine. Zmienili sme
sa aj o tom, že neistota sa skladá z niekol’kých
zložiek. Na určenie ich vel’kosti sú principiálne
k dispozı́cii tieto dve metódy:

ä štatistické spracovanie nameraných úda-
jov (metóda typu A),

ä iné ako štatistické spracovanie namera-
ných údajov (metóda typu B).

Niekedy sa neistoty zı́skané metódou A stručne
označujú ako neistoty typu A, podobne neis-
toty zı́skané metódou B ako neistoty typu B.
Z týchto základných typov neistôt sa potom
l’ahko pomocou súčtu ich štvorcov určı́ vý-
sledná kombinovaná neistota uC. Predpokladajme,
že máme jednoduchú výstupnú modelovú funk-
ciu niekol’kých vstupných parametrov f =
= F(x1, x2, . . . , xi, . . . , xm), kde f je odhad vý-
stupnej veličiny, xi sú odhady vstupných veličı́n
a F je známy funkčný vzt’ah. Vo všeobecnosti po-
tom môžeme pre neistotu u f odhadu f napı́sat’
vzt’ah

u f =

√
m

∑
i=1

A2
i u2

xi
, (9)

kde uxi sú jednotlivé zložky neistôt, Ai je koefi-
cient citlivosti (prevodu) prı́slušného zdroja ne-
istoty, ktorý poznáme alebo sa určı́ ako parciálna
derivácia funkcie f podl’a prı́slušnej vstupmej
veličiny xi

Ai =
∂ f
∂xi

=
∂F(x1, x2, . . . , xi, . . . , xm)

∂xi
. (10)

Vidiet’, že celá metodika určenia je dost’ kompli-
kovaná, preto v nasledujúcich častiach ukážeme
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len základnú metodiku a hĺbavého čitatel’a odká-
žeme na preštudovanie prı́slušnej literatúry (PA-
LENČÁR A KOL., 2000; VDOLEČEK A KOL., 2001a,b,
2002a,b; UHRIN A KOL., 2006; MELOUN A MILITKÝ,
2004).

Vyhodnotenie štandardných neistôt vstup-
nej veličiny metódou typu A

Metóda vyhodnotenia tohto typu neistôt je za-
ložená na štatistickej analýze opakovanej série
meranı́. Ked’ máme n nezávislých rovnako pres-
ných pozorovanı́ (n > 1), bude odhad výsled-
nej hodnoty f reprezentovaný hodnotou výbero-
vého priemeru (aritmetického priemeru) f i. Ne-
istota prislúchajúca odhadu f sa určı́ ako sme-
rodajná odchýlka s( f i) tejto výslednej hodnoty,
teda výberového priemeru f i. Tento typ neistoty
sa označı́ ako uA f a môžeme ju vyjadrit’ v tvare

uA f = s( f i) =
s( fi)√

n
=

√
∑n

k=1( fi,k − f i)2

n(n− 1)
.

(11)

Táto neistota je spôsobená kolı́sanı́m namera-
ných údajov. Ked’ máme k dispozı́cii malý počet
meranı́ (n < 10) je hodnota určená podl’a tohto
vzt’ahu nespol’ahlivá a mali by sme túto neis-
totu (spôsobenú kolı́sanı́m nameraných údajov)
odhadnút’ metódou typu B na základe iných in-
formáciı́ ako sú súčasné namerané údaje.

Vyhodnotenie štandardných neistôt vstup-
nej veličiny metódou typu B

Ako sme to už uviedli vyhodnotenie neistoty
vstupnej veličiny metódou typu B je založené
na iných ako štatistických postupoch analýzy sé-
rie pozorovanı́. Naskytuje sa možnost’ analógie
so systematickými zložkami chýb, avšak neide

o jednoznačnú súvislost’pretože metódou typu B
je možné odhadnút’ aj vplyv náhodnej chyby,
napr. pri kalibrácii použitı́m predchádzajúcich
meranı́. Štandardná neistota typu B sa odhaduje
pomocou racionálneho úsudku na základe všet-
kých možných a dostupných informáciı́. Najčas-
tejšie sa použı́vajú:

ä údaje výrobcu meracieho prı́stroja,

ä skúsenosti z predchádzajúcej série meranı́,

ä skúsenosti s vlastnost’ami správania mate-
riálov a techniky a poznatky o nich,

ä údaje zı́skané z kalibráciı́ a z certifikátov,

ä neistoty referenčných údajov v prı́ruč-
kach.

Pri určovanı́ neistoty typu B sa vychádza z čias-
tkových neistôt jednotlivých zdrojov uBzj . Ked’

poznáme maximálnu odchýlku j-teho zdroja ne-
istoty zj max, neistota uBzj sa určı́ podl’a vzt’ahu

uBzj =
zj max

k
, (12)

kde k je súčinitel’ zı́skaný zo zákona rozdelenia
pravdepodobnosti, ktorým sa riadi zdroj neis-
toty (napr. pre normálne rozdelenie je k = 2, prı́-
padne 3, pre rovnomerné rozdelenie k =

√
3, pre

trojuholnı́kové rozdelenie k =
√

6 atd’., podrob-
nosti pozri odkaz Rovnomerné rozdelenie pravdepo-
dobnosti).5 V niektorých prı́padoch môže byt’ už
neistota uBzj známa, napr. z kalibračného certifi-
kátu výrobcu meracieho prı́stroja. Výsledná ne-
istota sa metódou B určı́ podobne ako v prı́pade
závislosti vstupných funkciı́ od viacerých para-
metrov, pre p zdrojov z1, z2, . . . , zj, . . . , zp platı́

uB f =

√√√√ p

∑
j=1

A2
j u2

Bzj
, (13)

kde uBzj sú neistoty jednotlivých zdrojov a Aj

sú ich súčinitele citlivosti. Takýmto spôsobom sa
5V prı́padoch, ked’ môžeme odhadnút’ len dolnú (z−) a hornú hranicu (z+) meranej veličiny Xi a d’al’šie in-

formácie nemáme k dispozı́cii, je vhodné priradit’ (prisúdit’) meranej veličine rovnomerné rozdelenie a ako mieru

neistoty uB(Xi) použit’ odhad smerodajnej odchýlky s(Xi) tohto rozdelenia, teda uB(Xi) = s(Xi) =
√

(z+−z−)2

12 .
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neistota vyhodnocovaná metódou typu B pre-
vedie do nového tvaru a vzhl’adom na pred-
chádzajúce predstavy aj tieto neistoty ziskavajú
charakter smerodajnej odchýlky. Ako s takými,
prı́padne s ich druhými mocninami ako s rozp-
tylom, sa pracuje d’alej. V samostatnej časti to
ukážeme na prı́kladoch.

Kombinovaná a rozšı́rená neistota

V praxi sa zriedka vystačı́ len s jedným alebo dru-
hým typom neistoty samostatne. Potom je po-
trebné stanovit’ výsledný efekt kombinovaných
neistôt meranı́ (alebo určenı́) oboch typov, A a B.
Výsledná kombinovaná neistota veličiny f sa
označuje uC f a je vlastne odhadom smerodajnej
odchýlky spojenej s výsledkom, ktorý je rovný
druhej odmocnine kombinovaného rozptylu zı́s-
kaného zo všetkých rozptylov vstupných veličı́n;
druhej odmocnine zo súčtu štvorcov oboch ty-
pov neistôt A a B podl’a vzt’ahu

uC f =
√

u2
A f + u2

B f (14)

a zo všetkých prı́padných kovarianciı́. Postup na
stanovenie kombinovanej standardnej neistoty je
iný pre nekorelované a iný pre korelované veličiny.

Pre veličiny nekorelované (vzájomne nezávislé)
je kombinovaná standardná neistota uC f stano-
vená ako kladná druhá odmocnina z kombi-
novaného rozptylu u2

C f , ktorý sa určı́ pomocou
vzt’ahu

u2
C f =

n

∑
i=1

(
∂F
∂xi

)2
u2(xi), (15)

kde F je funkcia vyjadrujúca závislost’ výstupnej
veličiny f od vstupných veličı́n xi.

Pre veličiny korelované (vzájomne závislé) vstu-
pujú do neistôt aj ich kovariancie D(xi, xk) vzt’a-
hujúce sa na odhady xi a xk ako d’alšı́ vplyv na
vyjadrovanú neistotu

D(xi, xk) = u(xi) · u(xk) · r(xi, xk), (16)

kde r(xi, xk) je korelačný koeficient. Kovarian-
ciu dvoch náhodných veličı́n x(k)

i a x(k)
k , kto-

rých odhady sú zı́skané z hodnôt opakovaných
meranı́ a sú vyjadrené aritmetickými priemermi
x(k)

i a x(k)
k , môžeme určit’ podl’a nasledujúceho

vzt’ahu (horný index (k) vyjadruje, že máme do
činenia s korelovanými veličinami)

D(xi, xk)=
1

n− 1

n

∑
j=1

(x(k)
i,j − x(k)

i )(x(k)
k,j − x(k)

k ).

(17)

Kombinovaný rozptyl vzt’ahujúci sa na odhad
funkčne závislej výstupnej veličiny od korelova-
ných vstupných veličı́n je vyjadrený vzt’ahom

u2
C( f ) =

n

∑
i=1

(
∂F
∂xi

)2
u2(xi)+

+ 2
n−1

∑
i=1

n

∑
k=i+1

∂F
∂xi

∂F
∂xk

D(xi, xk).

(18)

Kombinovaná štandardná neistota je rovná od-
mocnine s takto vyjadreného kombinovaného
rozptylu. Z vyjadrenia rozvoja neistôt zı́skame
prı́spevky jednotlivých zdrojov neistôt k celko-
vej neistote, preto je vhodné previest’ v tejto fáze
analýzu prı́spevkov jednotlivých zdrojov celko-
vej (kombinovanej štandardnej) neistoty a na zá-
klade jej výsledku prı́padne previest’úpravu me-
todiky merania za účelom znı́ženia neistôt, ktoré
sa na celkovej neistote najviac podiel’ajú.

Tam kde nevystačı́me so štandardnými neisto-
tami je potrebné použit’ ich rozšı́renie pomo-
cou koeficientu rozšı́renia kr. Pôvodne stanovená
smerodajná odchýlka (teda aj štandardná neis-
tota) predstavuje napr. pri najčastejšie použı́va-
nom normálnom rozdelenı́ interval určený s prav-
depodobnost’ou asi 68 %. Podobne je to aj pri
iných typoch (zákonoch) rozdelenia pravdepo-
dobnosti. Aby sme dosiahli väčšı́ interval po-
krytia, blı́žiaceho sa k 100 %, je potrebné roz-
šı́rit’ štandardnú neistotu koeficientom rozšı́re-
nia kr, ktorého význam je v podstate zhodný s vý-
znamom kvantilov pri Gaussovom (normálnom)
rozdelenı́, kde kr = 2 pre rozšı́renie na 95%-nú
a kr = 3 pre rozšı́renie na 99,7%-nú pravdepo-
dobnost’ a pod. Rozšı́rená neistota je potom vy-
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jadrená vzt’ahom

U f = kr · uC f , (19)

kde U f je rozšı́rená neistota, kr je koeficient roz-
šı́renia a uC f je kombinovaná neistota. Výsledok
merania sa potom vyjadrı́ v tvare

f = f ±U f (20)

a znamená, že najlepšı́m odhadom meranej ve-
ličiny je f a že interval od f −U f do f + U f je
interval, od ktorého je možné očakávat’, že obko-
puje vel’kú čast’ hodnôt, ktoré môžu byt’ prira-
dené (prisúdené) výstupnej veličine f .

Zdroje neistôt

Ako zdroje neistôt možeme označit’ všetky javy,
ktoré nejakým spôsobom môžu ovplyvňovat’
neurčitost’ jednoznačného stanovenia výsledku
merania a tým odd’al’ujú (posúvajú) nameranú
hodnotu od skutočnej hodnoty. Vel’ký vplyv na
výsledok má aj tá skutočnost’ akú meraciu me-
tódu použı́vame, priamu alebo nepriamu. Na ne-
istoty tiež vplýva výber meracı́ch prı́strojov (ana-
logových alebo čı́slicových), vzorkovačov, pou-
žitie rôznych filtrov, iných prostriedkov a zaria-
denı́ v celej trase prenosu a úprave meraného
signálu. K neistotám výrazne prispievajú rušivé
vplyvy prostredia v najširšom slova zmysle. Na
tomto mieste spomenieme najčastejšie sa vysky-
tujúce zdroje neistôt:

ä nevhodný výber prı́stroja (rozlišovacia
schopnost’ a pod.),

ä neúplná alebo nedokonalaá definı́cia me-
ranej veličiny alebo jej realizácia,

ä nevhodný, resp. nereprezentatı́vny výber
vzoriek merania,

ä nevhodný postup pri meranı́,

ä zjednodušenie alebo nesprávne zaokrúh-
lenie konštánt a prevzatých hodnôt,

ä linearizácia, aproximácia, interpolácia
alebo extrapolácia pri vyhodnocovanı́,

ä nekompenzované alebo neznáme vplyvy
prostredia,

ä nedodržanie zhodných podmienok pri
opakovaných meraniach,

ä subjektı́vne vplyvy obsluhy (experimentá-
tora),

ä nepresnost’ etalónov a refernčných zdro-
jov alebo materiálov.

Niektoré zo zdrojov sa prejavujú významne
alebo výhradne v neistotách vyhodnocovaných
metódou typu A, iné zase pri požitı́ metódy
typu B. Mnohé zdroje môžu byt’ prı́činou oboch
skupı́n neistôt a preto vzniká nebezpečenstvo
v podobe zabudnutia (vynechania) jednej zo zlo-
žiek, čo môže mat’ výrazne skreslujúci účinok.
Situácia sa komplikuje, ked’ na meranie niekol’-
kých vstupných veličı́n použı́vame rovnaký me-
racı́ prı́stroj alebo ked’sú medzi vstupnými para-
metrami iné kovariačné väzby. Výsledná neistota
je potom podstatne väčšia a celá metodika spra-
covania nameraných údajov je primerane zloži-
tejšia.

Prı́klady stanovenia neistoty

Čı́sla, ktoré vyjadrujú výsledok merania v tvare
f = f ± U f (alebo f = f ± uC f ) sú zı́skané
výpočtom a majú obyčajne tol’ko desatinných
miest, kol’ko zobrazı́ použité výpočtové zaria-
denie (počı́tač, kalkulačka a pod.) V zobrazenom
čı́sle sa čı́slice s výnimkou núl na začiatku zobra-
zenej hodnoty označujú ako platné čı́slice, napr.
čı́slo 0,003 001 40 má šest’ platných čı́slic (miest).
Výsledná neistota merania sa zaokruhl’uje najviac
na dve platné čı́slice. Takýto postup vnáša do vý-
slednej čı́selnej hodnoty intervalu neistoty hod-
noty zaokrúhl’ovaciu chybu nanajvýš 0,5 %. Na-
prı́klad výsledkom výpočtu je čı́slo 0,004 3234,
zaokrúhlenı́m zı́skame hodnotu 0,004 3, alebo
výsledkom výpočtu je čı́slo 0,004 0234, zaok-
rúhlenı́m zı́skame hodnotu 0,004 0 (ked’ je dru-
hou platnou čı́slicou nula, treba ju vo výsledku
uviest’). Z formátu čı́sla vyjadrujúceho interval
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neistoty U f vyplýva aj formát čı́sla f , ktoré nemá
význam uvádzat’ v nižšom ráde ako je rád po-
slednej platnej čı́slice neistoty. Uvedieme prı́-
klady:

1. Výpočtom sme zı́skali tieto nezaokrúh-
lené čı́sla:

f = 38,395 799 cm2

U f = 0,155 9118 cm2

2. Po zaokrúhlenı́ ich zapı́šeme v tvare:

f = 38,40 cm2

U f = 0,16 cm2

3. Výsledok merania uvedieme v tvare:

f = (38,40± 0,16) cm2

4. Pri zaokrúhlenı́ na jedno (platné) desa-
tinné miesto:

f = (38,4± 0,2) cm2

5. Ďalšie možnosti zápisu výsledkov meranı́:

I = (8,37± 0,24) 10−3 A

p = (1,2017± 0,0024) Pa

λ = 2,037(4) nm

Poslednú formu zápisu výsledku merania pou-
žı́vajú niektoré odborné časopisy a nahradzuje
klasický tvar zápisu λ = (2,037± 0,004) nm.

Čı́slicový meracı́ prı́stroj6

Postup odhadu neistoty výsledku merania
(typ B) je pre daný typ meracieho prı́stroja oby-
čajne stanovený výrobcom. Ked’ nemáme k dis-
pozı́cii tento postup alebo nie je stanovený inak,

je neistota výsledku principiálne určená diskrét-
nym charakterom čı́selného údaja na displeji prı́-
stroja. Najjemnejšı́ krok delenia δ daného roz-
sahu meracieho prı́stroja Xmr je určený zmenou
údaja na poslednom digite o hodnotu ±1. Na-
prı́klad pre prı́stroj s pät’ digitovým displejom
je δ = 10−5 Xmr a meraná veličina sa s isto-
tou nachádza v intervale hodnoty zobrazenej na
displeji plus δ. Rozdelenie pravdepodobnosti vý-
skytu meranej veličiny v tomto intervale sa oby-
čajne považuje za rovnomerné. Potom sa stredná
hodnota meranej veličiny odhaduje hodnotou
zobrazenou na displeji plus δ/2 a prı́slušná neis-
tota výsledku sa odhadne štandardnou odchýl-
kou rovnomerného rozdelenia

uB =
δ√
12

=
δ

2
√

3
. (21)

Jedným zo zdrojov neistoty je rozlı́šitel’nost’po-
slednej platnej čı́slice. Napriek tomu, že sa pri
opakovanom meranı́ údaj na displeji nemenı́ nie
je neistota merania nulová. Pri odhade neistoty
sa použı́va model rovnomerného rozdelenia pravde-
podobnosti v intervale, ktorý je vymedzený rozli-
šovaciou schopnost’ou δ daného prı́stroja podl’a
vzt’ahu (21).

Príklad A:

Čı́slicový voltmeter opakovane ukazuje na disp-
leji napätie U = 14,12 V pri rozlı́šenı́ 10 mV
(presnost’ 10 mV), môžeme teda predpokladat’,
že δ(1) =0,01 V a neistota je rovná

u(1)
B =

0,01
2
√

3
= 0,002 886 75 V =

= 0,0029 V ≈ 0,003 V.
(22)

Údaj v technickej dokumentácii voltmetra nás
však informuje, že na rozsahu 20 V pri roz-
lı́šenı́ 10 mV (1 digit) má voltmeter presnost’

6Dovolená chyba čı́slicového voltmetra (ampérmetra) sa udáva súčtom relatı́vnej chyby v percentách δmh

z meranej hodnoty a relatı́vnej chyby δmr v percentách, vzt’ahuje sa na najväčšiu hodnotu meracieho rozsahu
prı́stroja (podrobnejšie pozri čast’5 Chyby elektrických meracı́ch prı́strojov).
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(0,3 % meranej hodnoty + 1 digit). Potom

δ(2) =
(

14,12
100

0,3 % + 0,01
)

=

= (0,042 36 + 0,01) = 0,052 36 V.
(23)

Prı́slušná zložka neistoty bude

u(2)
B =

δ(2)

2
√

3
=

0,052 36
2
√

3
=

= 0,015 115 03 V ≈ 0,015 V,

(24)

čo je ale hodnota 5× väčšia, ako z predchádzajú-
ceho výpočtu.

Príklad B:

Pri meranı́ čı́slicovým ampérmetrom s pia-
timi digitmi na rozsahu 10 A je údaj na disp-
leji I = 0,0035 A. Meraný prúd sa teda na-
chádza v intervale δI = (0,0035 ÷ 0,0036) A.
Strednú hodnotu meraného prúdu odhadneme
ako I = 0,003 55 A. Pre neistotu merania v prı́-
pade použitia modelu rovnomerného rozdelenia vý-
skytu meranej veličiny dostávame

uBI =
10−4

2
√

3
= 28,8675 · 10−6 A =

= 0,000 029 A
(25)

a pre model normálneho rozdelenia výskytu mera-
nej veličiny je vysledok neistoty rovný

uBI =
10−4

6
= 16,666 67 · 10−6 A =

= 0,000 017 A.
(26)

Výsledok merania pre model rovnomerného roz-
delenia potom zapı́šeme v tvare

I = (0,003 550± 0,000 029) A. (27)

Posuvné meradlo

V prı́pade posuvného meradla s najjemnejšı́m
delenı́m stupnice 0,1 mm, ked’ predpokladáme

rovnomerné rozdelenie pravdepodobnosti, je in-
terval neistoty výsledku merania podl’a predchá-
dzajúcej zásady (v časti Čı́slicový meracı́ prı́stroj)
rovný δ=0,2 mm a podl’a vzt’ahu (21)

uB =
0,1√

3
= 0,057 735 mm = 0,058 mm. (28)

Jednoduché meranie teploty

Bežným liehovým teplomerom meriame teplotu
kvapaliny v nádobe, pričom predpokladáme, že
na teplomer nepôsobia iné, ako v danom prı́pade
zanedbatel’né vplyvy (sálanie, premenlivá tep-
lota okolia, zmeny prúdenia vzduchu v miest-
nosti a pod.). Presnost’ merania teplomerom je
daná ako chyba odčı́tania teploty s vel’kost’ou
jedného dielika stupnice, čiže±1 ◦C. Výraz pres-
nost’ tu chápeme „klasicky“ prostrednı́ctvom
chyby, teda nie ako neistotu. Meranie prevá-
dzame opakovane v rôznych miestach nádoby
tak, aby bolo možné určit’ priemernú teplotu
kvapaliny. Predpokladom merania je aj to, aby
teplotné pole v meranom priestore bolo homo-
génne. Ked’ je táto podmienka splnená nemáme
dôvod uvažovat’ o d’alšı́ch prı́davných korek-
ciách a môžeme použit’ takýto postup. Opako-
vaným meranı́m, pri dostatočnej dobe ustále-
nia údaja teplomera (vylúčime prı́padnú dyna-
mickú chybu) sa zı́ska minimálne potrebných
desat’ meranı́. Odhadom priemernej teploty t je
aritmetický priemer zo všetkých desatich hod-
nôt t=35,4 ◦C. Štandardná neistota typu A je repre-
zentovaná smerodajnou odchýlkou súboru na-
meraných hodnôt od aritmetického priemeru

uA(t) =

√
1

n− 1

n

∑
i=1

(ti − t)2 = 0,360 ◦C. (29)

Štandardná neistota typu B má pri danom usporia-
danı́ merania jediný zdroj, ktorým je chyba od-
čı́tania s hodnotou ±1 ◦C. Oprávnene môžeme
predpokladat’ rovnomerné rozdelenie pravde-
podobnosti chyby teplomera, čiže

uB(t) =
1√
3

= 0,578 ◦C. (30)
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Kombinovanú štandardnú neistotu zı́skame zlúče-
nı́m oboch zložiek

uC(t) =
√

u2
A(t) + u2

B(t) =

=
√

0,3602 + 0,5782 = 0,681 ◦C.
(31)

Výsledok merania môžeme prezentovat’ pomocou
rozšı́renej neistoty s koeficientom rozšı́renia kr =2
(skutočná priemerná teplota sa nachádza v in-
tervale neistoty s asi 95%-nou pravdepodobnos-

t’ou), takže zápis po zaokrúhlenı́ na dve platné
miesta bude mat’ tvar

t = (35,40± 1,36) ◦C. (32)

V tabul’ke 1 uvádzame orientačné hodnoty od-

hadu chýb niektorých meracı́ch prı́strojov a za-

riadenı́.

Tabuľka 1: Hodnoty odhadu chýb niektorých meracı́ch prı́strojov

Meracie zariadenie Delenie stupnice Chyba zmax

Pásové meradlo 10 dielikov na 1 cm 1 mm

Posuvné meradlo 10 dielikov na nónius 0,1 mm

Posuvné meradlo 20 dielikov na nónius 0,05 mm

Posuvné meradlo 50 dielikov na nónius 0,02 mm

Mikrometer 50 dielikov na 0,5 mm 0,01 mm

Mechanické stopky 5 dielikov na 1 s 0,2 s

Digitálne stopky min : sek : sek
100 0,01 s

Teplomer 5, 2 alebo 1 dielik na 1 ◦C (0,2÷ 1) ◦C



Tvrdı́m len, že v každom štúdiu
prı́rody je len tol’ko vlastnej vedy,
kol’ko je v nej matematiky.

IMMANUEL KANT

2 Numerické metódy spracovania výsledkov meranı́

Úlohy súvisiace s vyhodnotenı́m experimentálnych dát vo fyzikálnej a technickej praxi sa
vyznačujú týmito základnými vlastnost’ami:

(a) rozsah a objem spracovaných dát obyčajne nie je vel’ký,

(b) v dátach sa nachádzajú aj vybočujúce hodnoty merania a rôzne nehomogenity,

(c) v dátach sa zvyčajne vyskytujú nelinearity, vzájomné väzby a pod., ktoré treba identi-
fikovat’ a opı́sat’,

(d) parametre modelov majú obyčajne definovaný fyzikálny význam,

(e) často narážame na istú neurčitost’ (nejasnost’, nepresnost’) pri výbere modelu na opis
dát.

Pri projektovanı́ pokusu je experimentátor vedený snahou zı́skat’ z meranı́ čo najviac fyzi-
kálne zaujı́mavých informáciı́.7 Preto experiment obyčajne prebieha za rôznych (kontrolo-
vaných) podmienok. Zmenou istých veličı́n sledujeme ich vplyv na iné veličiny. Vo väčšine
prı́padov takto zı́skame závislost’, o ktorej predpokladáme, že je spojitá funkčná závislost’
jednej veličiny od druhej veličiny. Napr. teplotnú závislost’ odporu, závislost’ anódového
prúdu magnetrónu od indukcie magnetického pol’a, závislost’ intenzity jadrového žiarenia
od hrúbky absorbátora atd’. Nameranı́m závislosti veličı́n práca experimentátora nekončı́, na-
opak, nasleduje najdôležitejšia úloha a to fyzikálne interpretovat’ výsledky meranı́. Pod pojmom
interpretácie budeme rozumiet’ odôvodnenie výsledkov. V podstate ide o určenie prı́čin, ktoré
spôsobujú daný výsledok. Experimentálna práca je takto z formálneho hl’adiska „obrátenou“
úlohou k teoretickému postupu, ktorý z definovaných podmienok (prı́čin) predpokladá zá-
very (následky) a tento fakt treba mat’ na zreteli pri spracovávanı́ merania. V konkrétnych

7Metóda pozorovania dáva cenné informácie o vonkajšı́ch javoch a vzt’ahoch (vel’kost’, tvar, časová následnost’ a pod.). Po-
znávaciu hodnotu však stráca vtedy, ked’sa pýtame na charakter vzt’ahov alebo na prı́činu javov. Hlbšie poznanie skutočnosti
umožňuje experimentálna metóda, ktorej použitie znamená ciel’avedomı́ zásah do pôvodného stavu zámernou zmenou, ktorá
je exaktne sledovaná za účelom zı́skania nových vedeckých faktov. Experimentálna metóda identifikácie zámerne vyvoláva
zmeny v skúmaných objektoch a na to použı́va najrôznejšie techniky. Cavier tento rozdiel medzi pozorovatel’om a expe-
rimentátorom vyjadril takto: „Pozorovatel’ prı́rode načúva, experimentátor ju vypočúva.“ Dáta zı́skané experimentom sa
stanú odpoved’ou na experimentátorovu otázku len po ich logickom spracovanı́, ktoré najčastejšie pozostáva z matematického
vyhodnotenia a poznávania, zo zovšeobecnenia zistených faktov.
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prı́padoch sa najčastejšie stretneme s týmito situáciami:

• Fyzikálna interpretácia meranej závislosti nie je dobre prepracovaná, tzn., že v čase
konania experimentu neexistuje teoretický model, ktorý by viac-menej úspešne pred-
povedal tvar funkčnej závislosti. Potom je možné zı́skané závislosti interpretovat’ iba
kvalitatı́vne, resp. v jednoduchých prı́padoch vyslovit’ hypotézu (napr. o lineárnej,
resp. inej závislosti).

• Teoretický model predpovedá očakávanú závislost’, napr. y= a + bx. Experiment8 line-
árnu závislost’ potvrdı́. Treba nájst’ „správne“ hodnoty parametrov, napr. a, b, ktorým
môžu odpovedat’ d’alšie dôležité informácie. Úlohami tohto druhu sa zaoberá vyrov-
návacı́ počet. V súčasnej dobe sa široko využı́va metóda najmenšı́ch štvorcov (NMŠ).9 Za
správne hodnoty sa považujú také hodnoty parametrov, ktoré dávajú najmenšı́ súčet
druhých mocnı́n odchýlok medzi nameranými a teoreticky predpovedanými hodnotami.

Pri spracovanı́ a interpretácii empirických dát nás v prvom rade zaujı́ma ich variabilita. Va-
riabilita experimentálnych údajov má obyčajne viacero prı́čin. Predovšetkým sa zaujı́mame
o efekty v systéme merania a v systéme, ktorý sledujeme, najmä o systematické vplyvy.
Ciel’om je porozumiet’ týmto vplyvom, aby sme mohli na systém merania prı́padne pôsobit’
a tým nežiadúce vplyvy úplne vylúčit’. Táto zložka variability je obyčajne prekrytá inou,
ktorej prı́činou je nepresnost’ merania a d’alšie náhodné vplyvy. K nı́m sa ešte pridáva aj
výberová chyba, ktorá vzniká tým, že namerané údaje obvykle zastupujú väčšı́ súbor. Údaje
(experimentálne dáta) v niektorých charakteristikách nesúhlasia vždy presne s charakteris-
tikami celého súboru (populácie), ktorých sa naše poznatky majú týkat’. Snažı́me sa teda
identifikovat’ základné vzt’ahy variability.

Vo výskume nám úlohu štatistiky najlepšie približuje predstava o signále a šume. Predstava
je taká, že dáta majú tvar

DÁTA = SIGNÁL + ŠUM,

kde signál reprezentuje informáciu o sledovanom systéme. Táto konštrukcia odzrkadl’uje,
že signál vyjadrujúci určité „pravidelnosti“ je viac-menej prekrytý šumom. Dáta však môžu
byt’ interpretované len ked’ disponujeme ich modelom, ktorého hlavnou čast’ou je nejaká
rovnica. Modelom sa usilujeme vystihnút’ podobu signálu, zjednodušene povedané model
odzrkadl’uje štruktúru dát. V štatistike teda dáta modelujeme podl’a schémy

DÁTA = MODEL(FUNKCIA) + REZIDUÁLNA HODNOTA,

8Experiment môžeme rozdelit’ na časti, ktoré sú do istej miery samostatné, voláme ich pokusy.
9Metódu najmenšı́ch štvorcov, ako výpočtovú procedúru opı́sal Adrien-Marie Legendre r. 1805 v práci Nouvelles

méthodes pour la détermination des orbites des comètes. On navrhol aj názov tejto metódy. Prvý, kto spojil metódu
najmenšı́ch štvorcov s teóriou pravdepodobnosti bol Carl Friedrich Gauss r. 1809 v práci Theoria motus corporum
coelestium in sectionibus conicus solem ambientium auctore, C. F. G. 1809. Poznamenal, že túto metódu použil už
roku 1795.
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kde reziduálna hodnota (v niektorých prácach nevhodne označovaná ako chyba) vyjadruje
rozdiel medzi modelom a meranými dátami, pričom je dôležité, aby tieto hodnoty neobsa-
hovali žiadnu evidentnú štruktúru. Pokial’ by reziduálne hodnoty mali nejakú štruktúru, je
potrebné model upravovat’ až dovtedy, kým nezahrnie všetky identifikovatel’né štruktúry
signálu. Modelom sa teda usilujeme čo najvernejšie reprezentovat’ reálny meraný systém.

Uvedieme hlavné črty metódy najmenšı́ch štvorcov. Majme nameranú funkčnú závislost’ fi =
= f (xi) v bodoch i=1, 2, . . . , n. Teoretický model predpokladá závislost’ y= F(x, p1, p2, . . .
. . . , pk), kde p1, p2, . . . , pk sú parametre, ktoré sa nedajú vypočı́tat’ v rámci tohto modelu
(čı́m menej parametrov, tým je model hodnotnejšı́).10 Odchýlky modelovej F∗ a experi-
mentálej funkcie fi, vypočı́tané v nameraných bodoch, označı́me ri (rezı́duum, reziduálna
hodnota)11

ri = F∗(xi, p∗1 , p∗2 , . . . , p∗k )− fi. (33)

Vzhl’adom na to, že považujeme kladné odchýlky za rovnako významné ako záporné, uva-
žujeme druhú mocninu ri.12 Ďalej označı́me

Φ =
n

∑
i=1

ri
2. (34)

Úlohou je nájst’ také odhady p̂1, p̂2, . . . , p̂k parametrov p1, p2, . . . , pk, pre ktoré funkcia
Φ (označovaná tiež ako účelová alebo kriteriálna) nadobúda minimum. Aby mala táto po-
žiadavka zmysel, musı́ byt’ splnených niekol’ko, nie práve samozrejmých predpokladov,
o ktorých sa musı́me pred začatı́m experimentu presvedčit’, pozri napr. (PETROVIČ A KOL.,
1989, I., str. 74):

1. chyba nezávisle premennej xi je zanedbatel’ne malá vzhl’adom na chybu
závisle premennej fi. Nezávile premenná by nemala korelovat’ s chybou
merania (poruchou) premennej fi,

2. chyba merania premennej fi je náhodná veličina z normálne rozdeleného
súboru, ktorý má nulovú strednú hodnotu a konštantný rozptyl v celej
oblasti merania. Táto požiadavka sa nazýva homoskedasticitou, preto lebo
skedastická funkcia je rovnaká (homogénna) pre všetky hodnoty nezávisle
premennej. Inak povedané, variabilita chýb by nemala vôbec zavisiet’ od
hodnôt nezávisle premenných. Ked’táto požiadavka nie je splnená hovorı́me
o heteroskedasticite.13

10Informáciu, ktorú nemôžeme zı́skat’ na základe modelu (teórie) treba nadobudnút’ empiricky, čiže analýzou
dát, čo je v niektorých prı́padoch vel’mi náročné a zložité.

11Rozdiel medzi chybou a rezı́duom je hlavne ten, že chyba je „teoretická“ hodnota, lebo nepoznáme hodnoty
parametrov p. Rezı́duum je presne určená hodnota a môžeme ho teda vziat’ do úvahy pri rozhodovanı́ ako
odhadnút’ regresné koeficienty

12Všeobecne sa uvažuje nejaká párna funkcia, t. j. funkcia f (x) taká, že f (x)= f (−x). Druhej mocnine sa dáva
prednost’ pred absolútnou hodnotou, lebo je to hladká funkcia.

13Systematické chyby ovplyvňujú experiment v rovnakom zmysle, ale vo všeobecnosti všetky merania rôznou
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Nutnou podmienkou pre minimum je potom splnenie rovnice

∂Φ
∂p∗j

= 2
n

∑
i=1

ri
∂ri

∂p∗j
= 2

n

∑
i=1

ri
∂F∗

(
xi, p∗1 , . . . , p∗k

)
∂p∗j

= 0 , j = 1, 2, . . . , k. (35)

Túto sústavu je možné explicitne riešit’v niektorých špeciálnych prı́padoch. Všeobecne treba
použı́vat’ vybrané numerické metódy (KAUKIČ, 2006; PIRČ A BUŠA, 2002). Preberieme si tie
funkčné závislosti, ktoré budeme potrebovat’ pri vyhodnocovanı́ laboratórnych záznamov.

2.1 Lineárna závislost’ y= a+bx a y= ax

Podl’a vzt’ahu (35) máme dva parametre p∗1 = a, p∗2 =b

ri = a + bxi − fi. (36)

Z rovnı́c (34) a (35) dostaneme sústavu dvoch lineárnych rovnı́c pre neznáme a a b, ktoré
môžme l’ahko vyriešit’. Riešenie zapı́šeme v tvare výhodnom na počı́tačové spracovanie.
Označı́me

s1 =
n
∑

i=1
xi, s2 =

n
∑

i=1
fi, s3 =

n
∑

i=1
x2

i ,

s4 =
n
∑

i=1
xi fi, s5 =

n
∑

i=1
f 2
i , ν=ns3 − s2

1.

Potom

â =
s2s3 − s1s4

ν
, b̂ =

ns4 − s1s2

ν
. (37)

Dá sa ukázat’, že pre štandardné neistoty odhadnutých parametrov â a b̂ platia tieto vzt’ahy:

σa = σab
f

√
s3

ν
, σb = σab

f

√
n
ν

. (38)

V experimentoch však nie vždy poznáme hodnotu štandardnej neistoty σf . Jej hodnotu
môžeme zı́skat’ len opakovanı́m merania. Pri jednom experimente však máme nameraných
n hodnôt f a ked’sme všetky zmerali s rovnakou chybou, môžemu ju odhadnút’ z rozdielov
medzi nameranými bodmi a funkciou (33) vzt’ahom14

σab
f =

√√√√√ n
∑

i=1

(
â + b̂xi − fi

)2

n− 2
. (39)

hodnotou. Majú nenulovú strednú hodnotu a prejavujú určitú mieru vzájomnej závislosti, t. j. sú korelované.
Nedodržanie predpokladu náhodnosti a nezávislosti chýb i nenulovosti ich stredných hodnôt znemožňuje
použitie štatistických metód vyhodnotenia.

14V menovateli vzt’ahu je hodnota n − 2 namiesto n z toho dôvodu, aby bol odhad nevychýlený. Ak máme
namerané iba dva body priamka určená metódou najmenšı́ch štvorcov prechádza presne cez ne a reziduálny
súčet štvorcov je rovný nule, vzt’ah predstavuje výraz typu 0/0. Musı́me mat’ teda namerané aspoň tri body,
aby sme z rozptylu bodov okolo priamky odhadli neistotu merania. Odhad je nevychýleny, ked’stredná hodnota
odhadu sa rovná jej skutočnej hodnote (nezávisle od počtu meranı́).
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Podobne pre závislost’ typu y = ax platia tieto vzt’ahy:

â =
s4

s3
, σa

f =

√√√√√ n
∑

i=1
(âxi − fi)

2

n− 1
, σa =

σa
f√
s3

. (40)

Odvodenie týchto vzt’ahov však presahuje rámec tejto práce a nie je ani jej ciel’om. Čitatel’ sa
môže o metóde najmenšı́ch štvorcov podrobnejšie dočı́tat’ napr. v prácach autorov (KUDRA-
CIK, 1999; LYONS, 2001; PETROVIČ A KOL., 1989; SQUIRES, 2001; WOLBERG, 2006)

Obrázok 1: Regresná priamka. Dvojice (Yi, Xi) sú
zı́skané meranı́m. Hodnota Ŷi je vypočı́taná pomo-
cou odhadnutých parametrov â a b̂ regresnej priamky
Yi = a + bXi

Hodnotu nezávisle premennej vypočı́tanú
pomocou regresnej rovnice nazývame aj vy-
rovnanou (odhadnutou) hodnotou Ŷ. Roz-
diel medzi odhadnutou a nameranou hod-
notou i-teho údaja je rezı́duum ri

ri = Ŷi −Yi. (41)

Ako sme to už spomenuli, rozdiel medzi
chybou a rezı́duom je hlavne ten, že chyba je
„teoretická“ hodnota, lebo nepoznáme hod-
noty koeficientov a a b. Rezı́duum je teda
presne určená hodnota a môžeme ho teda
vziat’ do úvahy pri rozhodovanı́ ako od-
hadnút’ regresné koeficienty. Pri hodnotenı́
regresného modelu si okrem iných kritériı́
teda všı́mame rezı́duá.

Prı́klady grafov reziduálnych hodnôt

Obrázok 2: Predpoklad vhodne zvoleného mo-
delu je splnený – homoskedasticita

Obrázok 3: Rozptyl bodov okolo regresnej krivky
sa zvyšuje s rastúcim x – heteroskedasticita
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Obrázok 4: Nutnost’ použit’ iný model, v prı́pade
lineárnej regresie použit’ niektorú nelineárnu re-
gresnú krivku

Obrázok 5: Priebeh nás upozorňuje, že časový fak-
tor by mal byt’ súčast’ou regresného modelu (ti je
časový okamih i-teho merania)

Odl’ahlé pozorovania

Obrázok 6: Graf zobrazuje dva neobvyklé body a
a b, ktoré môžeme klasifikovat’ ako odl’ahlé

ä Odl’ahlý bod je taký, ktorý ležı́
mimo základnú konfiguráciu bodov
v grafe.

ä Extrémne odl’ahlé pozorovania (extre-
mes) sú také body xi, ktoré pred-
stavujú zásadne odlišnú kombináciu
hodnôt x.

ä Vybočujúce odl’ahlé pozorovania (out-
liers) sú také, vysoké alebo nı́zke
hodnoty fi, ktoré sa zásadne lı́šia od
ostatných hodnôt f .

ä Bod nazývame vplyvným, ked’ sa po
jeho odstranenı́ podstatne zmenı́ po-
loha regresnej krivky.

ä Body, ktoré sú odl’ahlé v smere x sú
často vplyvné!

2.2 Polynomiálna závislost’

Parametrami sú koeficienty v polynóme k-teho stupňa

F∗ = akxk + ak−1xk−1 + . . . + a1x + a0 =
k

∑
l=0

alxl ,

ri =
k

∑
l=0

alxl
i − f (xi) ,

∂F∗(xi, ao, a1, . . . , ak)
∂aj

=
∂

∂aj

k

∑
l=0

alxl
i = xj

i
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a podl’a rovnice (35) dostaneme sústavu rovnı́c

∂Φ
∂aj

= 2
n

∑
i=1

[
k

∑
l=0

alxl
i − f (xi)

]
xj

i = 0.

Prehodenı́m poradia sumácie dostávame sústavu k + 1 rovnı́c pre k + 1 neznámych a0, . . . , ak

k

∑
l=0

Bjl al = yj, (42)

kde

Bjl =
n

∑
i=1

xl+j
i , yj =

n

∑
i=1

f (xi) xj
i .

Sústavu (42) je možné riešit’ napr. Gaussovou eliminačnou metódou. Pre k = 1 dostávame
lineárnu závislost’, pre ktorú je riešenie zhodné s rovnicou (37).

2.3 Exponenciálna závislost’

F∗ = αeβx, p∗1 = α, p∗2 = β, ri = αeβxi − f (xi)

a z rovnice (35) dostaneme

∂Φ
∂α

= 2
n

∑
i=1

[
αeβxi − f (xi)

]
eβxi = 0,

∂Φ
∂β

= 2
n

∑
i=1

α2xi e2βxi − 2 ∑
i

α f (xi) xi eβxi = 0,

čo je sústava transcendentných rovnı́c a na ich riešenie treba zvolit’ približné numerické
metódy. Aby sme sa tomu vyhli, pozmenı́me úlohu a namiesto extrému účelovej funkcie Φ
budeme hl’adat’ extrém funkcie Φ(L), v ktorej namiesto F∗ vystupuje ln F∗. Logaritmovanı́m
funkcie F∗ dostaneme

ln F∗ = ln α + β x.

Ak označı́me a= ln α, b= β, môžeme použit’ výsledky rovnice (37) pre lineárnu závislost’.

Poznámka:

Ak použijeme metódu najmenšı́ch štvorcov na takto transformovanú nelineárnu funkciu, hl’adané

parametre nezodpovedajú minimálnemu súčtu štvorcov odchýlok Φ = ∑n
i=1 [ln fi − ln F∗(xi)]

2,

pretože transformácia do súradnı́c prirodzeného logaritmu ovplyvňuje odchýlky rozdielne v rôz-

nych oblastiach pozdĺž krivky a tiež rozdielne ovplyvnı́ pozitı́vne a negatı́vne chyby v tých

istých bodoch krivky; preto treba problém riešit’ ako sústavu nelineárnych rovnı́c. Podl’a Bru-

novskej (1990, str. 50) však neexistuje všeobecné pravidlo pre nelineárne regresie, podl’a kto-

rého by bolo možné dat’ prednost’ jednej účelovej funkcii pred druhou. Ak rozptyl údajov nie
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je vel’ký, tento rozdiel nie je významný. Odhad cez transformáciu možno ešte zlepšit’ zave-

denı́m štatistickej váhy wi =
(

f
σf

)2

i
do účelovej funkcie (34), ktorá potom nadobudne tvar

∑n
i=1 wi [ln fi − ln F∗(xi)]

2 = min.

Transformácia dát a jej nedostatky
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Obrázok 7: Priebehy regresných funkciı́ preložené
experimentálne zı́skanými bodmi fitovanı́m transfor-
movanej a netransformovanej funkcie f (x, α, β) =
=α exp(−β x)

Použitı́m transformácie môžeme neline-
árnu funkciu

f (x, α, β)=α exp(−β x)

substitúciami y = ln f , α′ = ln α prepı́sat’
do lineárneho tvaru

y = α′ − βx.

Keby sme pre túto závislost’ použili me-
tódu najmenšı́ch štvorcov, hl’adané pa-
rametre by nezodpovedali minimálnemu
súčtu štvorcov odchýlok

Φ =
n

∑
i=1

[ln fi − ln f (xi)]
2

pretože, ako sme to už spomenuli, trans-
formácia súradnı́c do prirodzeného logaritmu ovplyvňuje odchýlky rozdielne v rôznych oblastiach
pozdĺž krivky a tiež rozdielne ovplyvnı́ negatı́vne a pozitı́vne chyby v tých istých bodoch krivky.
Pre konečné nezanedbatel’né chyby meranej premennej fi uvedená transformácia teda nie
je správna. Prejavı́ sa to naprı́klad vznikom heteroskedasticity. Pokial’ mali hodnoty fi kon-
štantný rozptyl σ2

fi
, hodnoty ln fi budú mat’ nekonštantný rozptyl

σ2
ln fi

=
(

σfi

fi

)2

,

t. j. konštantnú relatı́vnu chybu.

Preto nemôžeme použit’ jednoduchú linearizáciu vzt’ahu logaritmovanı́m, ale problém treba
riešit’ako sústavu nelineárnych rovnı́c. Prı́klad ilustruje obrázok 7. Aj ked’linearizačná trans-
formácia vedie k jednoduchému hl’adaniu odhadu parametrov, výsledkom je obvykle vy-
chýlený odhad, ktorého štatistická analýza je zložitejšia. Linearizáciu však môžeme použit’ na
určenie štartovacı́ch hodnôt odhadovaných parametrov pre nelineárnu aproximáciu MNŠ.

Záverom treba zdôraznit’, že funkcia F∗ (tzv. modelová funkcia) musı́ byt’ fyzikálne opod-
statnená. Ak sa predpokladá lineárna závislost’, nemá fyzikálne opodstatnenie vyrovnávat’
meranú závislost’ kvadratickou funkciou, i ked’môžeme očakávat’ „lepšiu“ zhodu v zmysle
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najmenšı́ch štvorcov. Aproximácia experimentálnych dát inými fyzikálne neodôvodnenými
funkciami má význam iba z hl’adiska vhodnejšieho uchovania informácie o experimentál-
nych dátach a z hl’adiska niektorých numerických operáciı́, napr. interpolácie a extrapolácie.

2.4 Nelineárna aproximácia MNŠ

Názvom lineárny model sa označuje model, ktorý je lineárnou kombináciou parametrov
regresného modelu. To znamená, že aj lineárny regresný model môže byt’z hl’adiska priebehu
modelovej funkcie nelineárny. Pre lineárny regresný model platı́ podmienka

Aj =
∂F(xxx, ppp)

∂pj
= konšt, j = 1, 2, . . . , k, (43)

kde xxx je vektor vysvetl’ujúcich (nezávisle) premenných a ppp je k členný vektor neznámych
regresných parametrov. Ked’ je parciálna derivácia Aj aspoň pre jeden parameter pj jeho
funkciou, ide o nelineárny regresný model15. Nelineárné regresné modely sa členia na:

(1) neseparabilné modely (podmienka (43) neplatı́ pre žiadny parameter modelu),

(2) separabilné modely (podmienka (43) platı́ aspoň pre jeden modelový parameter),

(3) vnútorne lineárné modely (môžeme ich korektnou transformáciou previest’ na lineárny
regresný model).

Majme opät’ teoretickú modelovú funkciu y = F(x, p1, p2, . . . , pk), kde pj, j = 1, 2, . . . k sú
neznáme (hl’adané) parametre. Predpokladajme, že vieme aké sú hodnoty parametrov pj

a tak pre každé xi môžeme určit’F∗(xi, p∗1 , p∗2 , . . . , p∗k ) ako aj rezı́duum

ri = F∗(xi, p∗1 , p∗2 , . . . , p∗k )− fi, i = 1, 2, . . . , n, (44)

kde fi sú namerané hodnoty a F∗ je aproximačná (účelová) funkcia. Skutočné rezı́duum ri

však nemôžeme určit’, lebo koeficienty p∗j nepoznáme. Úlohou je teda určit’ odhady p̂j

aproximačných koeficientov p∗j a rezı́duum

Ri = F∗(xi, p̂0
1, p̂0

2, . . . , p̂0
k)− fi, (45)

kde p̂0
1, p̂0

2, . . . , p̂0
k sú začiatočné odhady koeficientov p∗j a tieto už môžeme zı́skat’ napr. gra-

fickou metódou, použitı́m lineárnej MNŠ na transformovanú nelineárnu funkciu alebo od-
hadom zo znalosti úlohy.

Na určenie parametrov p̂j sa použı́va n meranı́ (pozorovanı́) závisle premennej fi a pri-
slúchajúcich hodnôt nezávisle premennej xi. Podobne, ako pri lineárnej MNŠ ciel’om je

15Takéto regresné modely sa často označujú aj ako inherentne nelineárné, čo znamená, že sú nelineárne v para-
metroch a lineárne alebo nelineárne v premenných.
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minimalizovat’ súčet štvorcov odchýlok meraných hodnôt fi od hodnôt určených pomocou
modelovej funkcie v bodoch xi, čo môžeme zapı́sat’ rovnicou

Φ =
n

∑
i=1

[F∗(xi, p∗1 , p∗2 , . . . , p∗k )− fi]
2 → min . (46)

V prı́pade, že minimum funkcie Φ budeme hl’adat’ tak, že jej parciálne derivácie podl’a p∗j
položı́me rovné nule, dostaneme sústavu k rovnı́c, ktorá má aj pre jednoduchú nelineárnu
funkciu F∗ zložitý tvar a nemusı́ mat’ jediné riešenie. Riešenı́m nemusı́ byt’ globálne mini-
mum funkcie Φ, ale môže ı́st’ o lokálne minimum alebo maximum, alebo inflexný bod. Aj
v prı́pade, že sa vol’bou „dobrých“ štartovacı́ch hodnôt dosiahne konvergencia, ide spra-
vidla iba o konvergenciu k lokálnemu minimu. Hl’adanie globálneho minima je však vecou
bádatel’a, ktorý model odhaduje (prı́padne ho vytvára), ale nie použitého algoritmu.

Na odhad hl’adaných parametrov p∗j sa použı́vajú iteračné metódy (PRESS ET AL., 1992; BRU-
NOVSKÁ, 1990; PETROVIČ A KOL., 1989; ZVÁRA, 1989). Týmito metódami sa vytvára postupnost’
odhadov parametrov modelu, pre ktoré funkcia Φ konverguje k minimálnej hodnote. Stručne
opı́šeme základ Gaussovej-Newtonovej metódy (metóda linearizácie), ktorá má oproti iným
metódam nelineárneho odhadu určité prednosti, o ktorých sa zmienime na záver.

Aproximačnú funkciu F∗ (deterministickú čast’ modelu) môžeme použitı́m Taylorovho line-
árneho rozvoja zapı́sat’ v tomto tvare

F∗(xi, p∗1 , p∗2 , . . . , p∗k ) ≈ F∗(xi, p̂0
1, p̂0

2, . . . , p̂0
k) +

∂F∗

∂p∗1
(p∗1 − p̂0

1)+

+
∂F∗

∂p∗2
(p∗2 − p̂0

2) + . . . +
∂F∗

∂p∗k
(p∗k − p̂0

k).
(47)

Ked’ vypočı́tame uvedený výraz pre hodnoty v každom xi a odpočı́tame fi od oboch strán
uvedenej rovnice, zı́skame vzt’ah medzi ri a Ri. Označme

∂F∗i
∂p∗k

=
(

∂F∗

∂p∗k

)
x=xi , p∗k = p̂0

k

,

potom môžeme zı́skaný výsledok (47) zapı́sat’ v tvare

F∗(xi, p∗1 , p∗2 , . . . , p∗k )− fi︸ ︷︷ ︸
ri

≈ F∗(xi, p̂0
1, p̂0

2, . . . , p̂0
k)− fi︸ ︷︷ ︸

Ri

+
∂F∗

∂p∗1
(p∗1 − p̂0

1)+

+
∂F∗

∂p∗2
(p∗2 − p̂0

2) + . . . +
∂F∗

∂p∗k
(p∗k − p̂0

k),

(48)

d’alej označme

Q =
n

∑
i=1

r2
i =

n

∑
i=1

[
Ri +

∂F∗i
∂p∗1

∆p1 + . . . +
∂F∗i
∂p∗k

∆pk

]2

.
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Pre odhad koeficientov p∗j metódou najmenšı́ch štvorcov platı́ Q = min. Vypočı́tame teda
derivácie pre Q(∆p1, . . . ∆pk)

∂Q
∂∆pj

= 2
n

∑
i=1

[
Ri +

∂F∗i
∂p∗1

∆p1 + . . . +
∂F∗i
∂p∗k

∆pk

]
∂D

∂∆pj
= 0, (49)

kde D = ∂F∗i
∂p∗1

∆p1 + . . . + ∂F∗i
∂p∗k

∆pk je úplný diferenciál funkcie F∗.

Dosadenı́m ∂D
∆p∗j

= ∂F∗
∂p∗j

do (49) a násobenı́m každého člena v zátvorke uvedeným členom
zı́skame rovnicu (49) v tvare

∂Q
∂∆p∗j

= 2
n

∑
i=1

[
∂F∗i
∂p∗j

Ri +
∂F∗i
∂p∗j

∂F∗i
∂p∗1

∆p1 + . . . +
∂F∗i
∂p∗j

∂F∗i
∂p∗k

∆pk

]
, j = 1, 2, . . . , k

a úpravou do maticového tvaru dostaneme

∑n
i=1

(
∂F∗i
∂p∗1

)2
∑n

i=1
∂F∗i
∂p∗1

∂F∗i
∂p∗2

. . . ∑n
i=1

∂F∗i
∂p∗1

∂F∗i
∂p∗k

∑n
i=1

∂F∗i
∂p∗2

∂F∗i
∂p∗1

∑n
i=1

(
∂F∗i
∂p∗2

)2
. . . ∑n

i=1
∂F∗i
∂p∗2

∂F∗i
∂p∗k

...
...

. . .
...

∑n
i=1

∂F∗i
∂p∗k

∂F∗i
∂p∗1

∑n
i=1

∂F∗i
∂p∗k

∂F∗i
∂p∗2

. . . ∑n
i=1

(
∂F∗i
∂p∗k

)2





∆p1

∆p2

...

∆pk


=



−∑
∂F∗i
∂p∗1

Ri

−∑
∂F∗i
∂p∗2

Ri

...

−∑
∂F∗i
∂p∗k

Ri


.

Riešenı́m tejto sústavy dostaneme pre vhodne zvolené začiatočné hodnoty p̂0
1, p̂0

2, . . . , p̂0
k

hodnoty ∆pj. Riešenie opakujeme pre nové začiatočné hodnoty p̂1
1 = p̂0

1+∆p1, p̂1
2 = p̂0

2+
+∆p2, . . . , p̂1

k = p̂0
k +∆pk dovtedy, dokedy nezı́skame dostatočne presné |∆pj| 5 ε, kde ε je

zvolená presnost’.

Výhodou Gaussovej-Newtonovej metódy je jej výpočtová jednoduchost’ a efektı́vnost’. V ite-
račnom procese ide o postupnost’ lineárnych odhadov s čı́m súvisı́ aj možnost’ využit’ šta-
tistické testy aplikované na lineárne modely. Ked’že sa pri každej iterácii vykonáva lineárny
odhad, môžeme použit’ štandardné štatistiky na overenie linearizovaného modelu (F–test,
t–test, index determinácie, χ2 test atd’.).

Poznámky k nelineárnej regresii

• Pri lineárnej regresii existuje jediné minimum pre váhovanú sumu štvorcov odchýlok,
avšak pri nelineárnej regresii spravidla existuje niekol’ko lokálnych minı́m pre rôzne p̂j.
Do ktorého minima metóda konverguje určuje vol’ba začiatočných hodnôt p̂0

j . Navyše
hlavné, globálne minimum nemusı́ znamenat’ „fyzikálne správne“ riešenie.

• V prı́pade, ked’ modelová funkcia obsahuje vel’a parametrov, existuje spravidla aj vel’a
lokálnych minı́m v sume štvorcov odchýlok. V takomto prı́pade metóda zle konverguje
alebo zı́skané hodnoty parametrov „citlivo“ závisia od vol’by začiatočných hodnôt.
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Preto je použitel’ný počet parametrov obmedzený a závisı́ hlavne od neistôt v nameraných
údajoch. Nepresným meranı́m (body sú vel’mi „rozhadzané“) nie je možné preložit’ krivku.

• Tak, ako pri všetkých numerických výpočtoch s väčšı́m počtom údajov, aj pri regresii
zohráva dôležitú úlohu numerická presnost’ počı́tača. Preto je potrebné najmä pri rozsiahlej-
šı́ch súboroch údajov modelovú funkciu, parametre a namerané dáta normovat’ tak, aby
sa prı́liš nelı́šili od rádu 100. Prı́klad normovania dát v prostredı́ programu MATLAB:
sdata=(xdata-mean(xdata))./std(xdata)

2.5 χ2 test kvality fitovania

Pri opise metódy najmenšı́ch štvorcov sme mlčky obišli otázku vplyvu chýb merania na
charakter a parametre (koeficienty) určovanej analytickej závislosti. Krátko sa zmienime
o tom, akú novú informáciu môžeme zı́skat’, ked’ vezmeme do úvahy štandardné (stredné
kvadratické) chyby experimentálnych dát. Predpokladajme, že máme k dispozı́ci n dvojı́c
meraných hodnôt (xi, fi), pričom chyba veličiny xi je zanedbatel’ne malá a chyba merania
veličiny fi je známa, rovná sa σfi .

Optimálny postup pre dáta s normálnou distribúciou šumu je taký, ktorý hl’adá minimum
kriteriálnej (účelovej) funkcie metódy najmenšı́ch štvorcov, t. j. váhovanej sumy štvorcov
rezı́duı́ alebo aspoň prostej reziduálnej sumy

χ2 =
n

∑
i=1

(
ri

σfi

)2

=
n

∑
i=1

(
F∗(xi, p̂1, . . . , p̂k)− fi

σfi

)2

, (50)

kde σfi je chyba merania veličiny f v bode i. Tento výraz sa volá funkcia χ kvadrát (chı́ kvadrát,
χ2) a metóda najmenšı́ch štvorcov, v ktorej sa aproximácia dát vykonáva so započı́tanı́m
chýb meranı́ sa volá metóda χ kvadrát. Poznamenajme, že χ2 je opät’ funkcia diskrétnej
premennej a prı́spevok jednotlivých členov (rozdielov teoretických a meraných dát) je tým
významnejšı́, čı́m presnejšie (s menšou hodnotou σfi ) je zmeraná hodnota fi. Je teda zrejmé,
že ked’ nepoznáme chyby σfi , nemôžeme vyslovit’ žiaden záver ohl’adne kvality fitovania.

Vo všetkých prı́padoch χ2 slúži, ako indikátor zhody medzi experimentálnymi a očakáva-
nými hodnotami nejakej premennej. Pri dobrej zhode bude χ2 stupňa n, pri zlej zhode bude
omnoho väčšie ako n. Kritérium môžeme použit’ len v tom prı́pade, ked’poznáme očakávané
hodnoty a štandardnú chybu. Pozrime sa na túto úlohu trochu podrobnejšie.

Pre jednoduchost’ budeme predpokladat’, že všetky merania sú zat’ažené rovnakými štan-
dardnými chybami σfi . Potom σfi = σf (pozri vzt’ahy 39 a 40) a v menovatel’och sumy
výrazu (50) bude vystupovat’ pre všetky merania rovnaké σf . Po derivovanı́ vzt’ahu (50) za
účelom hl’adania koeficientov polynómu dostaneme tú istú sústavu rovnı́c, ako v metóde
najmenšı́ch štvorcov. Ked’že do sústavy rovnı́c vstupujú tie isté experimentálne dáta, potom
prirodzene zı́skame aj rovnaké parametre (koeficienty). Je teda na mieste otázka, akú novú
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informáciu nám dá použitie známych hodnôt σf , ktoré nie sú obsiahnuté vo vypočı́taných
parametroch. Vzt’ah (50) má „väčšı́“ fyzikálny význam, ako vzt’ah (34), χ2 funkcia je bez-
rozmerná veličina, ktorá sa, ako vidı́me, rovná sume štvorcov odchýlok experimentálnych
bodov od teoretickej (optimálnej) krivky v násobkoch štandardnej chyby σfi .

Podmienka „fitovatel’nosti“ dát je splnená, ked’je počet k hl’adaných parametrov rovný alebo
menšı́ ako počet nameraných bodov n. Predpokladáme však, že v mnohých prı́padoch je
splnený taký scenár experimentu, v ktorom n � k. Zdravý rozum nám hovorı́, že ked’ má
byt’ fitovanie dobré, rozdiely ri by mali splňat’ rovnicu

ri = |yi − f (xi)| ≈ σfi . (51)

Je to len „hrubá“ indikácia, ale vždy je lepšia, ako letmý prelet očami „pozdĺž krivky“.16 Ked’

naše kritérium (51) dosadı́me do rovnice (50) dostaneme

χ2 ≈ n. (52)

Čı́m viac parametrov bude mat’ modelová funkcia použitá na fitovanie, tým tesnejšie bude
fitovaná krivka sledovat’ namerané dáta. Fitovanie budeme teda pokladat’ za dobré, ked’

k = n. Tento predpoklad nás vedie k tomu, aby sme aj s prihliadnutı́m na požiadavku
vyslovenú v úvode tejto časti, že modelová funkcia F∗(xi, p∗k ) je tým hodnotnejšia, čı́m má
menej parametrov, prijali praktické pravidlo pre dobrý výsledok fitovania v tvare

χ2 ≈ n− k, (53)

ktoré bude platit’ pre jednu sériu meranı́. Keby sme mohli zopakovat’ naše merania neko-
nečne mnoho ráz a po každej sérii vypočı́tat’ χ2, potom by sa jej stredná hodnota rovnala
n− k.

Najčastejšie môžu nastat’ dva prı́pady:

(a) ked’ bude χ2 � n − k nemôžeme vybranú modelovú funkciu F∗(xi, p∗k ) použit’ na
fitovanie nakol’ko σfi sú pre ňu „prı́liš malé“,

(b) ked’ χ2 � n − k fitovanie pokladáme za vel’mi dobré, môžeme sa domnievat’, že σfi sú
pre danú modelovú funkciu „dostatočne vel’ké“.

Vzt’ah (53) môžeme previest’ na vhodnejšı́ tvar, ked’zavedieme redukovanú hodnotu χ2 (alebo
χ2 na stupeň vol’nosti), pre ktorú platı́

χ̃ 2 =
χ2

n− k
. (54)

Ked’že podl’a (53) očakávame hodnotu n− k, má byt’ splnená rovnost’

χ̃ 2 = 1. (55)

16Garcia (2000) volá tento prı́stup eye-balling a Press (1992) chi-by-eye.
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Naše predchádzajúce kritériá (a) a (b) teda môžeme vyslovit’ v takomto znenı́: ked’ zı́skame
pre χ̃ 2 hodnotu rovnú rádovo jednotke alebo menej ako jedna, potom nemáme dôvod
pochybovat’ o našom modeli; ale ked’ je zı́skaný výsledok ovel’a väčšı́ ako jedna, potom je
nepravdepodobné, že náš model je správny.

Na rozdiel od predchádzajúceho prı́stupu môžeme použit’ χ2 štatistiku s prihliadnutı́m na
štatistické vlastnosti dát, ktoré budeme aproximovat’danou krivkou.17 V krátkosti uvedieme
základné myšlienky tohoto prı́stupu.

Ako sme to už spomenuli v úvode tejto časti, predpokladáme, že chyba meranej premennej f
je náhodná veličina z normálneho rozdelenia súboru. Za tohto predpokladu sú aj jednot-
livé ri nezávislé s normálnym rozdelenı́m, s nulovou strednou hodnotou a disperziou r2

i .
Potom sa suma štvorcov zapı́saná v tvare (50) riadi distribučným zákonom známym pod
menom χ2 rozdelenie (rozdelenie chı́ na druhú) s m stupňom vol’nosti. Pod stupňom vol’nosti
rozumieme počet nameraných bodov n znı́žený o počet parametrov k (vol’ných koeficien-
tov): m = n− k.18

Integrál typu

P
(
χ2 = χ2

0
)

=
∞∫

χ2
0

fm(x) dx, (56)

alebo jednoducho P
(
χ2), kde fm(χ2 = x) je hustota rozdelenia pravdepodobnosti pre rôzne

stupne vol’nosti, dovol’uje vypočı́tat’ kritické χ2
0 pre úroveň P

(
χ2 = χ2

0
)
. Tieto hodnoty sú

často vo forme tabuliek súčast’ou prı́ručiek a učebnı́c štatistiky, alebo sú dostupné ako sú-
čast’ štatistického softvéru, napr. program R. Na objasnenie uvedieme prı́klad, ako použit’
tabul’ku P(χ2). Predpokladáme, že máme súbor 20 meranı́. Experimentálne dáta zamýšl’ame
interpretovat’ lineárnou závislost’ou y = a + bx, pre ktorú vyčı́slime parametre a a b. V tomto
prı́pade sa počet stupňov vol’nosti rovná m=20− 2=18. Ďalej predpokladajme, že výpočtom
podl’a vzt’ahu (50) sme zı́skali hodnotu χ2 = 9. Z tabul’ky 2 pre P(χ2) zistı́me, že pri m = 18
stupňoch vol’nosti je pravdepodobnost’ zı́skat’ χ2 = 9 rovná ∼ 95 %. Odchýlka nameraných
údajov od očakávanej lineárnej závislosti je v tomto prı́pade nepodstatná. Keby sme zı́skali
výsledok χ2 =28, z tabul’ky zistı́me, že takúto a väčšiu hodnotu môžeme očakávat’ v asi 5 %
prı́padov. Model lineárnej závislosti nemusı́me zamietnut’, ale môžeme o ňom pochybovat’.
Prirodzene za takýchto okolnostı́ zopakujeme experiment, aby sme zı́skali nové dáta alebo
použijeme inú modelovú funkciu. V prı́pade, ked’ je χ2 = 42 (pravdepodobnost’ ≈ 0,1 %)
potvrdı́ sa, že preverovaná hypotéza je isto nesprávna (dané body nemôžeme aproximovat’

17Ako prı́klad nám môže poslúžit’ meranie elektrického výkonu na rezistore. Prúd I prechadzajúci rezistorom
sa riadi normálnym rozdelenı́m, ale výkon P sa nemôže riadit’ normálnym rozdelenı́m pretože normálne roz-
delenie pripúšt’a výskyt akejkol’vek reálnej (teda aj zápornej) hodnoty náhodnej premennej. Výkon elektrického
prúdu musı́ mat’ také rozdelenie, v ktorom platı́ f (x) = 0 pre x < 0. V tomto prı́pade ide o rozdelenie odvo-
dené z rozdelenia χ2. Takéto rozdelenie má veličina, ktorá je súčtom n kvadrátov nezávislých premenných so
štandardným normálnym rozdelenı́m.

18Ked’ sa chyby meraných hodnôt fi neriadia normálnym rozdelenı́m, úloha sa stáva ešte zložitejšou. Na jej
riešenie sa použı́va metóda, ktorá sa volá Metóda najväčšej hodnovernosti.
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lineárnou závislost’ou). Na podrobnejšie oboznámenie sa s danou problematikou odporú-
čame čitatel’ovi špecializovanú literatúru, napr. (PRESS ET AL., 1992; RIEČANOVÁ A KOL., 1987;
ZVÁRA A ŠTĚPÁN, 2001).

Tabuľka 2: Niektoré kritické hodnoty rozdelenia χ2. Uvedené sú hodnoty pravdepodobnosti P pre χ2 = χ2
P pri

m stupňoch vol’nosti

P

m 0,99 0,98 0,95 0,9 0,05 0,001

4 0,3 0,4 0,7 1,1 9,5 18,5

5 0,6 0,8 1,1 1,6 11,1 20,5

6 0,9 1,1 1,6 2,2 12,6 22,5

7 1,2 1,6 2,2 2,8 14,1 24,3

8 1,6 2,0 2,7 3,5 15,5 26,1

9 2,1 2,5 3,3 4,2 16,9 27,9

10 2,6 3,1 3,9 4,9 18,3 29,6

11 3,1 3,6 4,6 5,6 19,7 31,3

12 3,6 4,2 5,2 6,3 21,0 32,9

13 4,1 4,8 5,9 7,0 22,4 34,5

14 4,7 5,4 6,6 7,8 23,7 36,1

15 5,2 6,0 7,3 8,5 25,0 37,7

16 5,8 6,6 8,0 9,3 26,3 39,2

17 6,4 7,3 8,7 10,1 27,6 40,8

18 7,0 7,9 9,4 10,9 28,9 42,3

19 7,6 8,6 10,1 11,6 30,1 43,8

20 8,3 9,2 10,8 12,4 31,4 45,3

21 8,9 9,9 11,6 13,2 32,7 46,8

22 9,5 10,6 12,3 14,0 33,9 48,3

23 10,2 11,3 13,1 14,8 35,2 49,7

24 10,9 12,0 13,8 15,7 36,4 51,2

2.6 Výber modelu

Pri konštrukcii regresného modelu je obvykle našou snahou minimalizovat’ variabilitu vý-
sledku. Znı́ženie variability (numericky vyjadrenej najčastejšie pomocou smerodajnej od-
chýlky, intervalu spol’ahlivosti alebo neistoty) znamená zvýšenie presnosti. Môže pritom ı́st’
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o presnost’ napr. regresných koeficientov (parametrov), predikciu, limity detekcie a pod.
Najčastejšie použı́vané veličiny (štatistiky) na vyjadrenie variability sú:

• reziduálny rozptyl,

• smerodajná odchýlka parametrov,

• interval spol’ahlivosti.

Vo všetkých veličinách má rozhodujúci vplyv počet stupňov vol’nosti n − k. Rastúci počet
parametrov regresného modelu prispieva k znı́ženiu variability, teda k zvýšeniu „presnosti“
regresného modelu. Ked’ táto skutočnost’ nie je prevážená výrazne lepšı́m (tesnejšı́m) pre-
loženı́m dát, nemá pridávanie d’alšı́ch parametrov (napr. zvyšovanı́m stupňa polynómu)
žiadny zmysel. Preto nemôžeme na hodnotenie regresie použit’ korelačný koeficient alebo koe-
ficient viacnásobnej korelácie, ktorý počet parametrov vôbec neberie do úvahy. Na výber
optimálneho modelu môžeme napr. použit’ niektoré z týchto kritériı́:

• F – kritérium (max)

Fr =
(SST− SSE)(n− k)

SSE(k− 1)
, (57)

pri ktorom má štatistika Fr Fisherove rozdelenie s [(k− 1), (n− k)] stupňami vol’nosti,
kde SST= ∑( fi − f )2, SSE= ∑( fi − f̂ )2 a k je počet parametrov.

• Akaikeho informačné kritérium – AIC (min)

AIC = n ln
(

SSE
n

)
+ 2k. (58)

• Index korelácie Ik – charakterizuje silu (kvalitu) lineárnej závislosti, nadobúda hodnoty
z intervalu [0, 1].

Ik =
√

SST− SSE
SST

. (59)

Ako sme to už spomenuli, nevýhodou je, že zvyšovanı́m počtu regresných koeficientov
v modely (závislosti), môžeme dotlačit’ jeho hodnotu až k čı́slu 1.

• Index determinácie Id – tento index penalizuje vel’ký počet koeficientov

Id =

√
Ik −

(1− I2
k)(k− 1)

n− k
. (60)

Teda:

1. Z dvoch závislostı́ s rovnakým počtom regresných koeficientov je vhodnejšia tá,
pre ktorú je index korelácie Ik väčšı́.

2. Z dvoch závislostı́ s nerovnakým počtom regresných koeficientov je vhodnejšia tá,
pre ktorú je index determinácie Id väčšı́.
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2.7 Interpolácia a extrapolácia

Interpolácia

Meranı́m určı́me konečný počet hodnôt x1, x2, . . . , xn a im prislúchajúce f (x1), f (x2), . . .,
f (xn). Predpokladajme, že x1 < x2 < . . . < xn. Často nás zaujı́ma hodnota veličiny f pre ar-
gument x, ktorý sa nezhoduje so žiadnou z nameraných hodnôt a ležı́ v intervale x1 < x< xn.
Hodnotu funkcie f pre argument x odhadneme interpoláciou. Z formálneho hl’adiska expe-
riment poskytuje informácie iba o hodnotách funkcie v konečnom počte bodov a o hodnote
funkcie v bode x, kde sme meranie nevykonali, nemôžeme tvrdit’ nič, ak nemáme nejaké
d’alšie informácie. Tým, že cez body (x1, f1), (x2, f2), . . . , (xn, fn) „preložı́me krivku“, na-
hradı́me konečné postupnosti (spojitou) funkciou. Cez namerané body môže prechádzat’
vel’mi vel’a rôznych funkciı́. Ak z teórie poznáme funkciu, ktorá má prechádzat’ cez na-
merané body, postupujeme podl’a predchádzajúcej kapitoly. V opačnom prı́pade môžeme
funkčnú závislost’ medzi meranými bodmi nahradit’ jednoduchými funkciami, najčastejšie
lineárnou, kvadratickou, zriedkavejšie polynómom vyššieho stupňa. Hovorı́me o lineárnej,
kvadratickej alebo polynomiálnej interpolácii. Pri lineárnej interpolácii dostaneme „lomenú“
spojitú funkciu, ktorá však nemá derivácie práve v meraných bodoch. Pri kvadratickej in-
terpolácii môžeme dostat’ „hladšiu“ krivku, pri kubickej interpolácii a po častiach kubickej
interpolácii (napr. kubické splajny) môžeme dosiahnut’ spojitost’ derivácie atd’. Je zrejmé, že
čı́m hustejšie budú body namerané, tým menej sa budú lı́šit’ hodnoty zı́skané interpoláciou
rôznymi funkciami.

Naznačı́me postup pri interpolácii polynómom. Predpokladajme, že cez k + 1 nameraných
bodov prechádza polynóm k-teho stupňa, t. j., že platı́

f (xi) =
k

∑
j=0

ajx
j
i , i = 1, 2, . . . , k + 1. (61)

Dosadenı́m známych hodnôt xi a fi dostávame k + 1 lineárnych rovnı́c pre k + 1 neznámych
a0, a1, . . . , ak. Vyriešenı́m sústavy týchto rovnı́c dostaneme koeficienty a0, . . . , ak a môžeme
vypočı́tat’ hodnotu funkcie f (x) v l’ubovol’nom bode, ktorý ležı́ mimo bodov x1, . . . , xk+1

f (x) =
k

∑
j=0

aj xi, x ∈ (x1, xk),

pre k=1 dostávame lineárnu interpoláciu, pre k=2 kvadratickú, atd’. Samozrejme, na výpo-
čet koeficientov a0, a1, . . . , ak vyberieme tie experimentálne body, ktoré ležia v najbližšom
okolı́ bodu x. Počet meranı́ n je obvykle väčšı́ ako k.

Na prvý pohl’ad by sa zdalo, že zvyšovanı́m stupňa polynómu k sa zvyšuje aj presnost’ inter-
polácie. V skutočnosti merané veličiny xi a f (xi) sú zat’ažené neistotami, ktoré sa zvýrazňujú
pri výpočte vysokých mocnı́n hodnôt xi v (61). Z tohto dôvodu sa vo väčšine prı́padov
uspokojı́me s interpoláciou nı́zkeho rádu.
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Poznámka:

Ked’ hodnoty f (x1), f (x2), f (x3), . . . f (xn) boli zı́skané experimentálne a sú zat’ažené určitými

nezanedbatel’nými chybami, nie je spravidla vhodné metódu interpolácie aplikovat’. Je dokázané,

že za predpokladu normálneho rozdelenia chýb meranı́ s nulovou strednou hodnotou v každom

uzlovom bode najhodnovernejšie výsledky dosiahneme metódou najmenšı́ch štvorcov. Uvedené

predpoklady sú zvyčajne pri fyzikálnych alebo technických experimentoch splnené, preto je metóda

najmenšı́ch štvorcov najpoužı́vanejšou metódou aproximácie (vyhladenia šumu) experimentálne

zı́skaných dát.

Interpolácia nameraných dát splajn–funkciou 19

Interpolácia patrı́ k bežným operáciam pri spracovanı́ nameraných údajov, dovolı́ určit’ pri-
bližnú hodnotu medzi dvoma susednými bodmi nameranej závislosti. Neprirodzený prie-
beh má takáto interpolačná funkcia v okolı́ nameraných bodov, v ktorých vytvára zdánlivé
lokálne extrémy. Na ručné vykreslenie závislostı́ sa z tohto dôvodu použı́va krivı́tko alebo
prekladanie bodov naväzujúcimi kružnicami.

Metóda bola nazvaná podl’a pružného pravı́tka – splajn – použı́vaného na vytvárenie zaoble-
ných (hladkých) tvarov lodı́. Interpolácia splajn–funkciou, najčastejšie polynómom tretieho
stupňa, má rad výhod v porovnanı́ s klasickou interpoláciou polynómom prechádzajúcim
všetkými nameranými bodmi (najmä nižšia krivost’ vzhl’adom na menšı́ rád polynómu,
pri použitı́ kubického splajnu je výsledok blı́zky praktickej interpolácii pomocou pružného
pravı́tka).

Namerané hodnoty

f1, f2, . . . , fn (62)

pre hodnoty nezávislej premennej

x1, x2, . . . , xn (63)

chceme preložit’ (opı́sat’) optimálnou
interpolačnou krivkou na každom
úseku 〈xj, xj−1〉 kubickej paraboly.

Predpokladajme, že x1 < x2 < . . . xj−1 < xj < . . . xn a označme hj = xj − xj−1, pričom
hl’adáme súbor polynómov tretieho stupňa, ktoré v intervale 〈xj−1, xj〉 interpolujú funkčné
hodnoty a v hraničných bodoch na seba naväzujú tak, že vytvárajú hladkú krivku (čiaru).
Nájdený súbor polynómov nazývame splajn, pri použitı́ polynómov tretieho stupňa kubický

19Problém s hodnotami vypočı́tanými na základe lineárnej interpolácie je, že prvá derivácia lineárne interpo-
lovanej funkcie nie je spojitá. Pri riešenı́ úlohy, kde záležı́ na tom, aby sme z interpolovaných hodnôt dostali
funkciu so spojitou prvou deriváciou, musı́me použit’, napr. splajnové metódy vyhladzovania.
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splajn, ktorý má pre praktické vyhodnocovanie meranı́ najväčšı́ význam. Podmienkou hlad-
kosti krivky v hraničných bodoch je spojitost’, vrátane spojitosti deriváciı́ až do N − 1 rádu
(N je stupeň polynómu), čiže pre kubický splajn je potrebné zaistit’ spojitost’ aj pre druhú
deriváciu. V intervale 〈xj−1, xj〉 môžeme interpolačný polynóm zapı́sat’ v tvare

Sj(x) = a0 + a1(x− xj−1) + a2(x− xj−1)2 + a3(x− xj−1)3 (64)

pre j = 2, 3, . . . n. Koeficienty takého polynómu v intervale (x1, xn)

a0, a1, . . . , an (65)

sa dajú jednoznačne určit’ zo sústavy lineárnych algebraických rovnı́c

a0xN
j + a1xN−1

j + . . . + an−1xj + an = f j (66)

pre j = 0, 1, 2, . . . , n. Determinat sústavy je Wandermondov determinant, o ktorom je známe,
že je nenulový pre navzájom rôzne uzly (63). Sústava (66) má teda práve jedno riešenie (65).

Extrapolácia

Ak z meraného priebehu funkcie odhadujeme hodnotu f (x) v bode x, ktorý ležı́ mimo
intervalu nameraných hodnôt, hovorı́me o extrapolácii. Pri extrapolácii môžeme použit’ nu-
merické metódy ako pri interpolácii. Treba však mat’ vždy na zreteli, že pri extrapolácii
musı́me byt’ omnoho opatrnejšı́ ako pri interpolácii, hlavne ak x je d’aleko od meraného
intervalu. Pokial’ je možné, snažı́me sa nahradit’ extrapoláciu interpoláciou, t. j. meranı́m
obsiahnut’ čo najväčšı́ interval hodnôt xi. Mimo meraného intervalu môžu mat’ podstatný
vplyv nové fyzikálne javy, ktoré sa neprejavia v meranom intervale. Napr. pri meranı́ tep-
lotnej závislosti elektrického odporu vodiča v intervale teplôt od 10 ◦C do 40 ◦C nameráme
lineárnu závislost’ a extrapolujeme ju do 100 ◦C, pričom dodatočným meranı́m zistı́me, že
vodič sa roztopil pri teplote 80 ◦C, takže extrapolácia nad 80 ◦C je neprı́pustná.

Numerické metódy uvedené v tejto časti sú základnými metódami, ktoré si každý expe-
rimentátor, skôr či neskôr bude nútený osvojit’ a začat’ použı́vat’. S rozvojom výpočtovej
techniky, programovacı́ch metód a aplikačného softvéru sa rýchlo rozšı́rili do mnohých ob-
lastı́ prı́rodných vied a techniky. V nasledujúcich dvoch kapitolách čitatel’ovi predstavı́me
dva programy, ktoré umožňujú l’ahké a flexibilné použı́vanie uvedených metód na nume-
rické spracovnie experimentálnych dát a výsledky uložit’ do kvalitného grafického výstupu
v elektronickej alebo tlačenej podobe.



3 Program QtiPlot

QtiPlot je výkonný programový balı́k, ktorý poskytuje ako jednoduché tak aj vel’mi zložité
nástroje na analýzu dát a na kreslenie grafov. V tejto učebnej pomôcke sa budeme venovat’
opisu verzie QtiPlot 0.8.5 v prostredı́ OS GNU/Linux distribúcie UBUNTU 6.06. Domov-
ská internetová stránka programu je na URL adrese http://soft.proindependent.com/

qtiplot.html odkial’ sa dá program stiahnut’. Na prácu v QtiPlote existujú dva druhy okien
(pracovných prostredı́):

• tabul’kové

• a grafické.

Tabul’kové okno zobrazuje dáta potrebné na tvorbu grafu. V grafickom okne je vyobrazený
graf. Podl’a toho, ktoré z okien je aktı́vne, tabul’kové alebo grafické, menı́ sa obsah hlavnej
ponuky. V tejto kapitole opı́šeme obe hlavné ponuky a bude uvedený jednoduchý prı́klad
na tvorbu grafu. Vzhl’adom na rozsah možnostı́, ktoré poskytuje QtiPlot, budeme sa veno-
vat’ len tým funkciám a ponukám QtiPlotu, ktoré sú potrebné na numerické spracovanie
experimentálnych dát a ich grafickú prezentáciu.

3.1 Ovládacie možnosti programu QtiPlot

Otvorenie QtiPlotu sa dá uskutočnit’ troma spôsobmi:

• kliknutie na ikonu QtiPlot na pracovnej ploche,

• Menu → Škola hrou → Mathematics → kliknutie na QtiPlot,

• z prı́kazového riadka X terminálu prı́kazom qtiplot.

Pri prvom čı́tanı́ tejto kapitoly môže čitatel’, ktorý sa chce rýchlo oboznámit’ s použı́vanı́m
programu, čast’3.1 preskočit’ a pokračovat’ v čı́tanı́ čast’ou 3.2 na strane 47.

Na obrazovke sa zobrazı́ tabul’kové okno s prı́slušnými ponukami a ovládacı́mi prvkami (ob-
rázok 8). Zatvorenie QtiPlotu sa vykoná cez záložku File a potom Quit alebo stlačenı́m klá-
vesov Ctrl + Q (prı́padne Alt + F4).

3.1.1 Menu tabul’kového okna

Po vyvolanı́QtiPlotu sa na obrazovke zobrazı́ okno s menom projektuUNTITLED (obrázok 8).
Ako to vidiet’ na obrázku, ide o tabul’kové okno. Hlavné menu obsahuje tieto položky:

File Edit View Plot Analysis Tools Window Help

http://soft.proindependent.com/qtiplot.html
http://soft.proindependent.com/qtiplot.html
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Obrázok 8: Tabul’kové okno programu QtiPlot

V d’alšom stručne opı́šeme tie položky, ktoré sú potrebné na základné zoznámenie sa s mož-
nost’ami QtiPlotu.

File

New vytvorenie nového projektu

Open otvorenie súboru s prı́ponou .qti,

editácia už vytvoreného projektu

Recent Projects zoznam piatich naposledy otvorených

projektov

Open image file importovanie obrázku (jpg, bmp, gif, png a iné)

do QtiPlot projektu

Import image . . . importovanie obrázkového súboru a konver-

tovanie intenzity obr. do maticovej tabul’ky

Save Project uloženie dokumentu pod pôvodným menom

Save Project as uloženie dokumentu pod novým menom
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Open Template otvorenie uloženej šablóny 2D grafu, 3D grafu,

tabul’ky a matice

Save as Template uloženie šablóny aktuálneho objektu

Print vytlačenie aktı́vneho grafu

Print All Plots vytlačenie všetkych grafov projektu

Export ASCII exportovanie ASCII dátového súboru z tabul’ky

Import ASCII importovanie súboru ASCII s prı́ponou .dat

Quit ukončenie práce s programom QtiPlot

Edit

Undo zrušı́ posledný vykonaný krok

Redo vráti posledný vykonaný krok

Cut selection vybratie vyznačenej oblasti

Copy selection skopı́rovanie vyznačenej oblasti

Paste selection vloženie skopı́rovanej oblasti

Delete selection zmazanie vyznačenej časti dát (aj celého stĺp-

ca, ak je vyznačený)

Delete fit tables vymazanie obsahu tabul’ky s hodnotami na

vykreslenie fitovanej funkcie, zmizne aj graf

vytvorený z týchto dát

Clear log information vymazanie obsahu log súboru s informáciami

o výsledkoch fitovania

Plot

Line pospájanie bodov do jednej lomenej čiary

Scatter bodový graf

Line + Symbol čiarový graf s vyznačenými bodmi

Special Line/Symbol zvislé čiary alebo „schodı́ky“, splajnová čiara

Columns stĺpcový graf, zvislé stĺpce

Rows stĺpcový graf, ale stĺpce sú vodorovné

Area graf s vyfarbenou plochou pod čiarou grafu

Pie koláčový graf

Vectors XYXY vytvorenie vektorového grafu,

prvé dva stĺpce musia obsahovat’ hodnoty

začiatočných súradnı́c vektora a posledné dva
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koncové súradnice vektora

Vectors XYAM vytvorenie vektorového grafu,

prvé dva stĺpce musia obsahovat’ hodnoty

začiatočných súradnı́c vektora a posledné dva

uhol (v radiánoch) a amplitúdu vektora

Statistical Graphs štatistické grafy

Panel viac grafov v jednom okne

Plot 3D trojdimenzionálne grafy

Analysis

Statistics on Columns štatistické vyhodnotenie dát v stĺpci

Statistics on Rows štatistické vyhodnotenie dát v riadku

Sort Columns usporiadanie dát v stĺpci

Sort Table usporiadanie dát v celej tabul’ke

Normalize normalizovanie dát v stĺpci alebo vo všetkých

stĺpcoch tabul’ky

FFT . . . analýza dát v tabul’ke rýchlou Fourierovou

transformáciou

Correlate výpočet korelácie dát dvoch vybraných

stĺpcov tabul’ky

Convolute výpočet konvolúcie dát z dvoch vybraných

stĺpcov tabul’ky, prvý reprezentuje signál

a druhý funkciu

Deconvolute výpočet dekonvolúcie dát z dvoch vybraných

stĺpcov tabul’ky, prvý reprezentuje signál

a druhý funkciu

Non-linear Curve Fit nelineárna aproximácia dát vybraného stĺpca

tabul’ky (nesmú tvorit’ priamu úmernost’)

Table

Set columns as nastavenie dát v stĺpci (X, Y, Z, nenastavené)

Column Option . . . nastavenie vlastnostı́ stĺpca (počet riadkov,

typ dát, formát čı́siel a pod.)

Set Column Value . . . matematické operácie s dátami v stĺpci

Fill Column with vyplnenie stĺpca tabul’ky vzostupnými
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alebo náhodnými čı́slami

Add column pridanie nového stĺpca do tabul’ky

Columns . . . pridanie stĺpcov do tabul’ky,

nastavenie počtu stĺpcov v tabul’ke

Rows . . . pridanie riadkov do tabul’ky,

nastavenie počtu riadkov v tabul’ke

Convet to matrix konverzia dát v tabul’ke do maticového tvaru

Po konverzii tabul’ky do maticového tvaru v hlavnom menu pribudnú položky 3D aMatrix.
V položkeMatrix nájdeme prı́kazy na vytvorenie transponovanej a inverznej matice, vypočet
determinantu štvorcovej matice, úpravu dát vo vytvorenej maticovej tabul’ke a konverziu
maticovej tabul’ky na XY tabul’ku.

3.1.2 Menu grafického okna

Po vykreslenı́ grafu z tabul’kových dát sa zmenı́ hlavné menu a namiesto položiekPlot aTable
budú Graph a Format a pribudne ešte položka Data (obrázok 9).

Obrázok 9: Grafické okno programu QtiPlot
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V d’alšej časti uvedieme ponuky, ktoré budeme potrebovat’ na vytvorenie grafu a numerickú
analýzu dát.

Graph

Add/Remove Curve . . . pridanie/odobratie krivky do/z grafu

Add Error Bars zobrazenie chyby nameraných dát úsečkami

Add Function . . . pridanie užı́vatel’om definovanej funkcie

New Legend pridanie legendy (obnovenie vymazanej)

Add Text pridanie l’ubovolného textu (po kliknutı́ na

graf sa otvorı́ okno na editovanie textu)

Draw Arrow/Line pridanie šı́pky alebo úsečky so šı́pkou

Add time stamp pridanie dátumu a času

Add Image pridanie obrázka (jpg, bmp, gif, png a iné)

Add Layer pridanie nového grafu do grafického okna

Remove Layer odobratie grafu z grafického okna

Arrange Layers úprava grafov (pı́smo, tituly, popis osı́, . . . )

Data

Disable tools zapnutie všeobecného kurzora

Zoom zapnutie lupy

Rescale to show all prekreslenie grafu do celého okna

Data reader kliknutı́m na bod sa otvorı́ okno

Data display a zobrazia sa súradnice

Select data range umožnı́ kurzorom myši alebo šı́pkami

klávesnice vybrat’ určitý rozsah dát

Screen reader čı́tač súradnı́c, otvorı́ okno Data display

a načı́ta súradnice hociktorej pozı́cie

v okne grafu

Move data Points . . . umožnı́ premiestnenie bodov grafu,

zmeny sa prejavia aj v tabul’ke

Remove Bad Data Points . . . umožnı́ odstránenie bodov z grafu,

y-ové hodnoty bodov sa vymažú

z tabul’ky
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Analysis

Translate prekladanie dát vo vodorovnom

a zvislom smere

Differentiate výpočet prvej derivácie z dát

Integrate numerický výpočet integrálu

Smooth „vyhladenie“ krivky metódou FFT filtra,

metódou pohyblivého priemeru

a Savitzkého-Golayovou metódou

FFT filter rôzne filtre (dolno a hornopriepustný,

pásmový priepustný a blokový)

Interpolate . . . interpolácia dát (lineárna, kubická

a Akimova)

FFT . . . inverzná a dopredná FFT

Fit Linear lineárna regresia

Fit Polynomial . . . polynomická regresia do 9. stupňa

Fit Exponential Decay regresia exponenciálnou tlmenou krivkou

Fit Exponential Growth . . . regresia exponenciálnou rastovou krivkou

Fit Boltzmann (Sigmoidal) regresia Boltzmannovou funkciou

Fit Gaussian regresia Gaussovou funkciou

Fit Lorentzian regresia Lorentzovou funkciou

Fit Multi-peak regresia na vyznačené maximá

Gaussovou alebo Lorentzovou funkciou

Non-linear Curve Fit . . . nelineárna regresia Nelderovou-

-Meadovou simplexovou

a Levenbergovou-Marquardtovou

metódou, k dispozı́cii sú základné

matematické funkcie, sedem vsta-

vaných funkciı́ a je tu aj možnost’

definovat’ vlastné funkcie

Format

Plot . . . otvorı́ sa okno so záložkami s možnost’ami editovat’

rozsah, popis a formát osı́, formát mriežky a všeobecné

vlastnosti grafu

Curves . . . otvorı́ sa okno na editovanie grafických vlastnostı́ krivky

Scales . . . nastavenie rozsahu osı́
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Axes . . . editovanie formátu osı́

Grid . . . editovanie formátu mriežky grafu

Title . . . editovanie názvu grafu

3.2 Prı́klady použitia programu

3.2.1 Zadávanie a import dát do tabul’ky

Zadanie vlastných dát priamo do tabul’ky

Vo fyzikálnych, chemických a iných laboratóriách zı́skavame namerané hodnoty, ktoré po-
trebujeme vyhodnotit’ napr. štatistickými metódami, vykonat’ regresnú analýzu rôznymi
funkciami a výsledky chceme znázornit’ ako čiary v grafoch. Práve na grafické zobrazenie
meranı́ a ich vyhodnotenie s výhodou môžeme použit’QtiPlot.

Graf vo všeobecnosti chápeme ako grafické zobrazenie funkcie y = f (x), pričom x je ne-
závisle a y závisle premenná veličina. V tabul’kovom okne (obrázok 8) vkladáme do stĺpca
1[X] nezávisle premennú a do stĺpca 2[Y] a d’alšı́ch stĺpcov 3[Y], 4[Y] atd’. závisle premenné.
Počet premenných definujeme podl’a našich požiadaviek, v prı́pade potreby vytvárame d’al-
šie stĺpce prı́kazom Table → Add column alebo pravým klikom myši v hlavičke tabul’ky
vyberieme z kontextového menu Add column.

Importovanie dátoveho súboru boxbod.dat

V úvode sme spomenuli, že funkcionalitu programu sme skúšali dátami z internetovej
stránky Národného inštitútu štandardov a technológiı́ Spojených štátov amerických (NIST,
2006). Stiahli sme si dáta z kolekcie pre nelineárnu regresiu s názvom BoxBOD20, ktoré
sú zaradené do kategórie s vysokou náročnost’ou na spracovanie. Tabul’ka bola uložená
do dátového súboru s názvom boxbod.dat. Tento súbor teraz importujeme, postupným
vyvolanı́m nasledovných ponúk File→ Import ASCII→ Set import option, nastavı́me formát
importovaných dát a potom vykonáme import dát do tabul’ky, napr. z nástrojovej lišty
kliknutı́m na ikonu

Vyhl’adáme súbor boxbod.dat, po vol’be sa údaje prenesú do tabul’ky, pozri obrázok 10.

V prı́pade potreby môžeme premenovat’ nazvy stĺpcov tabul’ky. Klikneme 2× na polı́čko
1[X], otvorı́ sa okno s názvom Column option, v ktorom môžeme zmenit’ názov stĺpca, počet

20 http://www.itl.nist.gov/div898/strd/nls/nls_main.shtml

http://www.itl.nist.gov/div898/strd/nls/nls_main.shtml
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Obrázok 10: Tabul’kové okno s importovanými
dátami

Obrázok 11: Tabul’kové okno s importovanými

dátami, premenovaným prvým stĺpcom a zmenou
formátu dát

desatinných miest čı́selnej hodnoty premennej v stĺpci, šı́rku stĺpca, názov premennej a iné
parametre (obrázok 12). Výsledok úpravy vidı́me na obrázku 11.

Obrázok 12: Možnosti formátovania tabul’kového okna

3.2.2 Vytvorenie a úprava grafu

Kliknutı́m do hlavičky tabul’ky a t’ahom myši (alebo stlačenı́m klávesu Shift a súčasným
pohybom klávesových šı́pok) vyznačı́me stĺpce závisle a nezávisle premennej a z hlavného
menu zvolı́me Plot → Scatter. Vykreslia sa body do grafu s názvom graph 1 (obrázok 13).
Graf by sme mohli nazvat’ „surovým“. V tomto grafe je zobrazená legenda a v l’avom
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Obrázok 13: Zobrazenie dát tabul’ky z obrázku 10

hornom rohu grafického okna je okienko 1 . Pokial’ by sme nevyznačili v dátovej tabul’ke
nezávisle premennú, dvojklikom na toto okienko sa otvorı́ dialógové okno Add/Remove
curves, v ktorom je ponuka presunutia údajov z okienka Available data do okienka Graph
contents a potom kliknutı́m na položku Plot Association . . . si môžeme vybrat’ nezávisle aj
závisle premennú, ktoré chceme zobrazit’ v grafe.

Pomenovanie osı́ vykonáme dvojklikom na jednotlivé osi grafu alebo z hlavného menu zvo-
lı́me Format → Plot . . .→ Axis a prevedieme požadované úpravy. Dvojklikom do rámčeka
s legendou v l’avom hornom rohu grafu sa otvorı́ okno na editovanie legendy. Ak je to
potrebné urobı́me úpravy, zmeny sa prejavia klikom na položku Apply. Ukončenie editácie
potvrdı́me klikom na položku OK alebo Cancel. „Surový“ graf má názov Title, jeho preme-
novanie môžeme urobit’ dvojklikom myši na tento názov alebo z hlavného menu zvolı́me
Format → Title . . . , otvorı́ sa okno na editovanie textu, napı́šeme nový názov a premeno-
vanie potvrdı́me klikom na položku Apply, pričom samozrejme môžeme použit’ aj pı́smo
s diakritikou, grécke pı́smená, symboly a pod., pozri obrázok 18. Editáciu názvu ukončı́me
klikom na položku OK alebo Cancel. Podobným postupom zmenı́me aj názvy osı́.
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Dvojklikom na l’ubovolný bod grafu môžeme zmenit’ tvar, farbu a vel’kost’ symbolov na
vykreslenie dát. V prı́pade, že v grafe máme hustú siet’ kriviek aj s dátami, odporúča sa
toto editovanie vykonat’ z hlavného menu Format → Curves . . . Opı́sané úpravy vidı́me na
obrázku 14.

Obrázok 14: Upravený graf z obrázku 13

3.2.3 Nelineárna regresia pre súbor boxbod.dat

Aproximujme dáta znázornené v grafe na obrázku 14 exponenciálnou závislost’ou v tvare

y = a[1− exp(−bx)],

ktorá je podl’a (NIST, 2006) modelovou funkciou pre tieto dáta. V hlavnom menu klikneme
na položku Analysis → Non-linear Curve Fit . . . a vyberieme ponuku User defined. Do l’avého
dolného okna zapı́šeme aproximačnú rovnicu a*(1-exp(-b*x)), do okienka Name vpı́šeme
názov funkcie, napr. boxbod, do okienka Parameters vpı́šeme symboly a, b fitovaných pa-
rametrov oddelených čiarkou a medzerou, potom kliknutı́m na položku Save vytvorenú
funkciu uložı́me (objavı́ sa v zozname Function), pozri obrázok 15. Klikom myši na prvok zo-
znamu z oknaCategory sa zobrazı́ v okne Function zoznam funkciı́ z danej kategórie (vybrané
položky sa podfarbia modrou farbou). Vyberieme si samozrejme tú našu boxbod. V prı́prave
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na fitovanie pokračujeme zaškrtnutı́m polı́čka Fit with selected user function a potom kliknu-
tı́m na položku Fit>>. Otvorı́ sa nám okno, v ktorom nastavı́me štartovacie hodnoty Initial
guesses, vyberieme algoritmus fitovania, rozsah nezávisle premennej, maximálny počet ite-
ráciı́ a toleranciu na ukončenie procesu (obrázok 16). Kliknutı́m na položku Fit sa odštartuje
fitovanie a po jeho ukončenı́ sa na pracovnej ploche objavı́ tabul’ka Result Log s výsledkami,
pričom sa v grafe zobrazı́ regresná krivka (obrázok 17). Výsledky fitovania môžeme vložit’

Obrázok 15: Okno na definovanie fitovacej funk-
cie pre dáta boxbod.dat

Obrázok 16: Okno na definovanie požadaviek fi-
tovania pre dáta boxbod.dat

do pol’a grafu kopı́rovanı́m tabul’ky cez schránku, pričom môžeme použit’ postup na edito-
vanie a vkladanie textu do plochy grafu Graph → Add text. Výsledok vidı́me znázornený na
obrázku 18 a uvádzame tu aj tabul’ku výsledkov:

16.09.2006 00:08:27 Fit1:

Non-linear fit of table3_2,

using function boxbod(x, a, b)=a*(1-exp(-b*x))

Scaled Levenberg-Marquardt algorithm with tolerance = 0.0001

From x=1 to x=10

a=213.811069200896 +/- 0.723006

b=0.547218222427426 +/- 0.00611864

-----------------------------------

Chi^2/doF = 292.002

-----------------------------------

Iterations = 7

Status = success

Výpis nás informuje o dátume a čase fitovania, že toto fitovanie údajov z tabul’ky table3 2

funkciouboxbod je prvé v tomto projekte, urobené nelineárnou metódou použitı́m Levenbergovho-
-Marquardtovho algoritmu s toleranciou 0.0001. Ďalej sa uvádza rozsah nezávisle premen-
nej x, fitované parametre a a b so štandardnými neistotami, hodnota χ̃2, počet iteráciı́ a na-
pokon hlásenie, že proces fitovania bol ukončený úspešne.
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Obrázok 17: Hlásenie programu o ukončenı́ a o výsledkoch fitovania

Obrázok 18: Nelineárna regresia dát BoxBOD exponenciálnou funkciou
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3.2.4 Lineárna regresia funkciou y = ax

V krátkosti ešte opı́šeme postup lineárnej regresie modelovou funkciou

y = ax,

ktorú použijeme na fitovanie dát NoInt1 z kolekcie pre lineárnu regresiu už spomenutého
inštitútu NIST (2006)21. V položke Analysis máme sı́ce ponuku Fit Linear pre modelovou
funkciou y = a + bx, ale akosi jej chýba možnost’ riešit’ prı́pad, ked’ parameter a = 0. Po-
môžeme si teda definovanı́m vlastnej funkcie y = a*x, ktorú nazveme line. Zopakujeme
postup, ktorý sme použili v predošlom prı́klade nelineárnej regresie, výsledok vidı́me na
obrázkoch 19 a 20. Štartovaciu hodnotu parametra a nacháme implicitnú a = 1 a taktiež
algoritmus fitovania ponecháme bez zmeny. Jediné čo zmenı́me je začiatočná hodnota ne-
závisle premennej, ktorú nastavı́me na hodnotu 0, aby sa graf zobrazil tak, ako ten, ktorý
je na WWW stránke inštitútu NIST. Grafický výsledok nie je „oslňujúci“, trochu ho upra-
vı́me, aby bolo jasné, že závislost’ má rozsah v oboch smeroch osı́ od 0. Z hlavného menu
vyberieme položku Format → Axes → Scale a začneme s úpravami. Najprv zmenı́me x-ový
rozsah, úpravu potvrdı́me klikom na Apply, postup zopakujeme pre y-ový rozsah. Očakávali
sme, že čiara fitu bude predĺžená do začiatku súradnicového systému, nestalo sa tak, pozri
obrázok 21.

Obrázok 19: Okno na definovanie fitovacej funk-
cie pre dáta NoInt1

Obrázok 20: Okno na definovanie požadaviek fi-
tovania pre dáta NoInt1

Programu na jej vykreslenie pravdepodobne chýba bod (0, 0). Úpravu môžeme vykonat’
dvoma spôsobmi:

21 http://www.itl.nist.gov/div898/strd/lls/lls.shtml

http://www.itl.nist.gov/div898/strd/lls/lls.shtml
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Obrázok 21: Prvé okno na definovanie požadaviek fitovania pre dáta NoInt1

1. Tabul’ku Fit2, ktorá obsahuje dáta na zobrazenie fitovanej čiary doplnı́me bodom (0, 0)
tak, že na jej začiatok vložı́me nový riadok s hodnotami x = 0 a y = 0. Klikneme
na značku prvého riadku tabul’ky, vyfarbı́ sa na modro, potom pravým klikom vybe-
rieme z kontextového menu Insert Row. Do vytvorených prázdnych polı́čok vložı́me
nuly. Touto úpravou dosiahneme to, že sa zobrazenie fitovanej čiary v grafe začne
z bodu (0, 0). Teraz už môžeme náš obrázok porovnat’ s obrázkom, ktorý je na WWW
stránke inštitútu NIST, pozri obrázok 22. Výpis výsledku fitovania:

18.09.2006 16:27:38 Fit1:

Non-linear fit of table1_C2, using function line(x, a)=a*x

Scaled Levenberg-Marquardt algorithm with tolerance = 0.0001

From x=60 to x=70

a=2.07438016528688 +/- 0.00463316

-----------------------------------

Chi^2/doF = 12.7273

-----------------------------------

Iterations = 2

Status = success

2. Môžeme zopakovat’ postup z bodu 1 pre tabul’ku table1 s dátami noint1.dat a urobit’
nové fitovanie pre x od 0 do 70. Mohli by sme namietat’, že je to „násilné konanie“
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pridat’ do tabul’ky body a tak ovplyvnit’ fitovanie. Priložené výpisy však ukazujú, že
v oboch prı́padoch sú zı́skané parametre rovnaké. Výpis výsledku fitovania:

22.01.2006 01:51:44 Fit7:

Non-linear fit of table1_2, using function: user1(x, a, b)=a*x

Scaled Levenberg-Marquardt algorithm with tolerance = 0.0001

From x=0 to x=70

a=2.07438 +/- 0.00463

b=0.00000 +/- 0.00000

-----------------------------------

chisq/dof = 12.7273

-----------------------------------

Iterations = 2

Status = success

Ako vzor na „kozmetickú“ úpravu grafu nám môže poslúžit’ prı́klad z obrázku 28. Urobı́me
ju pomôckami z položky Format a hotový projekt uložı́me.

Obrázok 22: Druhé okno na definovanie požadaviek fitovania pre dáta NoInt1
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3.3 Spôsoby zobrazenia viacerých grafov

Stáva sa, že sa vyžaduje zakreslenie dvoch (a niekedy aj viacerých) fyzikálnych veličı́n rôz-
nych rozsahov do jedného grafu alebo zlúčit’viac grafov do jedného obrázku. Napr. chceme
zobrazit’ priebeh rýchlosti a zrýchlenia vol’ného pádu gul’ôčky vo viskoznom prostredı́. Za
predpokladu, že pohyb gul’ôčky sa deje iba vo zvislom smere vel’mi malou rýchlost’ou jej
pohybová rovnica má tvar, pozri napr. (UHRIN A KOL., 2006, str. 50)

4
3

πr3ρ
dv
dt

=
4
3

πr3gn(ρ∗ − ρ)− 6πrηv, (67)

kde r je polomer gul’ôčky, v rýchlost’ jej pohybu vzhl’adom na pokojnú tekutinu, ρ je hustota
(objemová hmotnost’) gul’ôčky, ρ∗ je hustota tekutiny, gn je normálne tiažové zrýchlenie a η

je viskozita tekutiny.

Predchádzajúca rovnica je lineárna diferenciálna rovnica prvého rádu s konštantnými koefi-
cientami s pravou stranou. Rieši sa známymi štandardnými metódami a jej riešenie pre
počiatočnú podmienku – rýchlost’ v čase nula sa rovná nule – má tvar

v = v0

[
1− exp

(
−9

2
η t
r2ρ

)]
, (68)

v0 =
2 r2(ρ∗ − ρ) gn

9 η
.

Závislost’ rýchlosti od času je teda daná rozdielom dvoch členov. Člen v0 je časovo nezávislý,
druhý člen je exponenciálne klesajúci, ktorý po určitom čase prakticky vymizne a gul’ôčka sa
bude pohybovat’rovnomerne a priamočiaro rýchlost’ou v0. Časový priebeh zrýchlenia bude
rovný prvej derivácii rýchlosti v podl’a času

a = a0 exp
(
−9

2
η t
r2ρ

)
, (69)

a0 =
(ρ∗ − ρ)gn

ρ
.

Urobı́me numerický výpočet rýchlosti v a zrýchlenia a pre pohyb plexisklovej gul’ôčky
o polomere r = 1 mm vo vode v časovom intervale od 0 do 2 sekúnd. Pomocou možnosti
vkladania funkciı́ do grafov, z hlavného menu grafického okna vyberieme Graph → Add
Function. . . Čı́selné hodnoty v0, a0 a konštantného člena v exponentoch sú:

v0 =
2 r2(ρ∗ − ρ) gn

9 η
=

2(10−3)2(998− 1 200) 9,81
9 · 10−3 = −0,44 m s−1

a0 =
(ρ∗ − ρ)gn

ρ
=

(998− 1 200) 9,81
1 200

= −1,65 m s−2

9
2

η t
r2ρ

=
9 · 10−3

2(10−3)21 200
= 3,75 s−1

Znamienko mı́nus v prvých dvoch výrazoch má fyzikálny význam. Uvedomme si, že v a a
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sú vlastne z-ové zložky rýchlosti a zrýchlenia v pravouhlom súradnicovom systéme a teda
môžu byt’ kladné aj záporné.

V prvom kroku vytvorı́me čı́selné hodnoty na zobrazenie rýchlosti v a zrýchlenia a, ktore
použijeme na tvorbu kombinovaných grafických výstupov. Začneme novým projektom,
potom z položky File v hlavnom menu vyberieme New Function Plot. Otvorı́ sa ponuka Add
function curve, do okienka f(x)= vložı́me 0.44*(1-exp(-3.75*x)) pre x od 0 do 2 a necháme
vypočı́tat’ 100 hodnôt, klikneme na OK. Okno programu sa prepne do grafického módu
a zobrazı́ sa priebeh nami zadanej funkcie f(x)=0.44*(1-exp(-3.75*x)) vo forme spojitej
čiary, obrázok 23. Vypočı́tané hodnoty potrebujeme uložit’ do dátového súboru. Kurzorom

Obrázok 23: Grafický priebeh vzt’ahu 68

myši na čiare vykonáme dvojklik, otvorı́ sa editor parametrov čiary. Klikneme na položku
Worksheet, aktivuje sa tabul’kové okno a zobrazı́ sa tabul’ka vypočı́taných hodnôt rýchlosti,
ktorú uložı́me postupom File → Export ASCII, vyberieme oddel’ovač stĺpcov a pomenujeme
ju rychlost.dat. Postup zopakujeme na vytvorenie dát zrýchlenia, do okienka f(x)= vložı́me
1.65*exp(-3.75*x) pre x od 0 do 2 a opät’ necháme vypočı́tat’ 100 hodnôt. Dátový súbor
uložı́me pod menom zrychlenie.dat. Teraz už máme uložené dáta potrebné na vytvorenie
ukážok.
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3.3.1 Zobrazenie dvoch priebehov v jednom grafe

Uložené dáta rychlost.dat a zrychlenie.datpoužijeme na vytvorenie dvoch priebehov v jednom
grafe.

Začneme novým projektom, z ktorého vymažeme prázdnu tabul’ku a budeme doňho impor-
tovat’ naše dáta, File → Import ASCII → Multiple files. . . alebo na nástrojovej lište klikneme
na ikonku Import multiple data files

Vyhl’adáme naše súbory, pričom súčasným stlačenı́m klávesu Ctrl a klikom myši ich ozna-
čı́me na importovanie. V okne programu budeme mat’dve tabul’ky table2 s dátami rýchlosti
a table3 s dátami zrýchlenia. Označı́me stĺpce tabul’ky table2 a z položky Plot hlavného
menu vyberieme bodové zobrazenie Scatter, otvorı́ sa grafické okno s priebehom rýchlosti.
Do tohto grafu chceme vložit’ aj priebeh zrýchlenia. Na túto operáciu použijeme postup
opı́saný v časti 3.2.4 na strane 53. Klikneme teda do okienka 1 a v editore Add/Remove
curves presunieme dáta table3 z okna Available data do okna Graph contents. Výsledok vidı́me
na obrázku 24. Graf upravı́me pomôckami z položky Format a projekt nezabudnime uložit’.
Upravený graf vidı́me na obrázku 25. Pre d’al’šie použitie môžeme graf uložit’ v niektorom
z grafickych formátov cez hlavné menu položkou File → Export Graph→ Current, napr. eps.

Obrázok 24: Zobrazenie dát zo súčasne impor-
tovaných súborov rychlost.dat a zrychlenie.dat

Obrázok 25: Upravený graf z obrázku 24

3.3.2 Zobrazenie dvoch grafov v jednom okne

V tejto časti opı́šeme postup ako zlúčit’viac grafov do jedného obrázka použije na to naše dáta
rychlost.dat a zrychlenie.dat. Opät’ začneme prácu novým projektom, z ktorého vymažeme
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prázdnu tabul’ku a do tohto projektu importneme naše data postupom z predchádzajucej
časti. Z tabul’kového okna sériou prı́kazov Plot → Scatter vykreslı́me priebeh rýchlosti.
Do aktı́vneho grafického okna, v ktorom je graf priebehu rýchlosti v, vložı́me nový graf
pomocou ponuky Graph → Add Layer z hlavného menu programu, potvrdı́me implicitnú
ponuku kliknutı́m na položku Guess. V l’avom hornom okne pribudne okienko 2 , klikneme
naň dvakrát, otvorı́ sa editor Add/Remove curves a môžeme presunút’ tabul’ku table3 do
Graph contents. Výsledok nášho snaženia vidı́me na obrázku 26. Grafy upravı́me pomôckami

Obrázok 26: Neupravené grafy priebehov rých-
losti v a zrýchlenia a v jednom grafickom okne

Obrázok 27: Upravené grafy z obrázku 26

z položky Format a vytvorený projekt nezabudnime uložit’. Upravené grafy sú na obrázku 27.
Na d’alšie použitie môžeme obrázok s grafmi uložit’ v niektorom z grafickych formátov cez
hlavné menu položkou File → Export Graph → Current, napr. eps, png, jpeg, bmp, pbm, pgm,
ppm, xbm, xpm. Na obrázku 28 sú oba projekty znázornené v jednom grafickom okne, na
postup vyhotovenia pozorný čitatel’ už iste prı́de aj sám.

Stručne sme ukázali niektoré často použı́vané procedúry spracovania dát a tvorby grafov.
Týmito jednoduchými prı́kladmi sme samozrejme nevyčerpali všetky možnosti programu
QtiPlot. Dobrým zdrojom d’alšı́ch informáciı́ na prácu s programom je elektronický off-line
HTML manuál prı́stupný na URL adrese: http://soft.proindependent.com/manuals.html.

V priloženej tabul’ke uvádzame zoznam programom podporovaných matematických ope-
rátorov a zabudovaných funkciı́, ktoré môžeme použı́vat’ na vytvorenie vlastných funkciı́,
pri matematických operáciach s dátami v tabul’kách a pod.

http://soft.proindependent.com/manuals.html
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Obrázok 28: Zobrazenie dvoch grafov v jednom okne a dvoch priebehov v jednom grafe

ZOZNAM MATEMATICKÝCH OPERÁTOROV A FUNKCIÍ PROGRAMU QtiPlot

Názov Popis

+ súčet

− rozdiel

∗ násobenie (a*b = a·b)

/ podiel, delenie

ˆ umocnenie (a^b = ab)

and logické AND (vracia 0 alebo 1)

or logické OR (vracia 0 alebo 1)

xor logické Exclusive OR (vracia 0 alebo 1)

< menšie ako (vracia 0 alebo 1)

<= menšie ako alebo rovná sa (vracia 0 alebo 1)

pokračovanie tabul’ky na d’al’šej strane
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(pokračovanie tabul’ky z predošlej strany)

Názov Popis

== rovná sa (vracia 0 alebo 1)

>= väčšie ako alebo rovná sa (vracia 0 alebo 1)

> väčšie ako (vracia 0 alebo 1)

! = nerovná sa (vracia 0 alebo 1)

abs(x) absolútna hodnota x

acos(x) arkus kosı́nus

acosh(x) arkus hyperbolický kosı́nus

asin(x) arkus sı́nus

asinh(x) arkus hyperbolický sı́nus

atan(x) arkus tangens

atanh(x) arkus hyperbolický tangens

avg(x1,x2,x3,...) stredná hodnota argumentov

bessel j0(x) Besselova funkcia prvého druhu J0(x) rádu 0

bessel j1(x) Besselova funkcia prvého druhu J2(x) rádu 1

bessel jn(x,n) Besselova funkcia prvého druhu Jn(x) rádu n

bessel y0(x) Besselova funkcia druhého druhu Y0(x) rádu 0

bessel y1(x) Besselova funkcia druhého druhu Y1(x) rádu 1

bessel yn(x,n) Besselova funkcia druhého druhu Yn(x) indexu n

beta(a,b) Beta funkcia, B(a, b) = Γ(a) · Γ(b)/Γ(a + b)

cos(x) kosı́nus x

cosh(x) hyperbolický kosı́nus x

erf(x) chýbová funkcia

erfc(x) erfc(x)=1-erf(x)

erfz(x) hustota pravdepodobnosti normálneho rozdelenia Z(x)

erfq(x) koncová čast’ normálneho rozdelenia Q(x)

exp(x) exponenciálna funkcia so základom e

gamma(x) funkcia Γ(x)

gammaln(x) logaritmus funkcie Γ(x)

pokračovanie tabul’ky na d’al’šej strane
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(pokračovanie tabul’ky z predošlej strany)

Názov Popis

hazard(x) h(x)=erfz(x)/erfq(x)22

if(e1,e2,e3) ked’ je e1 pravdivé , výpočı́ta sa e2 a ešte e3

ln(x) prirodzený logaritmus x

log(x) dekadický logaritmus x

log2(x) logaritmus x so základom 2

min(x1,x2,x3,...) minimum zo zoznamu argumentov

max(x1,x2,x3,...) maximum zo zoznamu argumentov

rint(x) zaokrúhlenie na najbližšie celé čı́slo

sign(x) funkcia znamienka x

sin(x) sı́nus x

sinh(x) hyperbolický sı́nus x

sqrt(x) druhá odmocnina z x

tan(x) tangens x

tanh(x) hyperbolický tangens x

22V staršej literatúre sa uvádza pojem hazard function ako ekvivalent pojmu hazard rate alebo failure rate
použı́vaneho v teórii obnovy a poist’ovnı́ctve, v slovenčine ako intenzita poruchy (úmrtnosti). Je definovaná
ako h(x) = f (x)/(1− F(x)), kde f (x) a F(x) je hustota a distribučná funkcia doby životnosti nejakého prvku
(J. Skřivánek).



4 Program Kpl

ProgramKpl je jednoduchý z pohl’adu ovládania, poskytuje rozsiahle možnosti na vyhladzo-
vanie, optimalizáciu a numerické operácie s nameranými dátami (napr. derivovanie, integro-
vanie); môžeme ho dopĺňat’ vlastnými funkciami a knižnicami, ktoré sa napı́šu a skompilujú
v programovacom jazyku C. Na rozdiel od programu QtiPlot neumožňuje štatistické vý-
počty a charakteristiky dát. V d’alšı́ch častiach opı́šeme prácu s verziou Kpl 3.3 pre grafické
použı́vatel’ské prostredie KDE 3.5.2.

Domovská internetová stránka programu je na URL adrese http://frsl06.physik.uni-freiburg.
de/privat/stille/kpl/. Autor Werner Stille ponúka k programu on-line prı́ručku prı́stupnú
na URL adrese http://frsl06.physik.uni-freiburg.de/privat/stille/kpl/book/index.html

. Na prácu v Kplmáme k dispozı́cii jedno pracovné okno, pozri obrázok 29.

Obrázok 29: Pracovné okno programu Kpl

http://frsl06.physik.uni-freiburg.de/privat/stille/kpl/
http://frsl06.physik.uni-freiburg.de/privat/stille/kpl/
http://frsl06.physik.uni-freiburg.de/privat/stille/kpl/book/index.html
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4.1 Ovládacie možnosti programu Kpl

Spustenie Kpl v prostredı́ OS GNU/Linux sa dá uskutočnit’ troma spôsobmi:23

• kliknutie na ikonu Kpl na pracovnej ploche (ked’ ju máme vytvorenú),

• Menu → Kancelária → kliknutie na Kpl (ked’ sme program inštalovali z deb balı́čka),

• z prı́kazového riadka X terminálu prı́kazom kpl.

Na obrazovke sa zobrazı́ okno programu s prı́slušnými ponukami a ovládacı́mi prvkami v hlav-
nom menu (obrázok 29). Zatvorenie Kpl sa vykoná cez záložku File a potom Quit alebo
stlačenı́m klávesov Ctrl + Q (prı́padne Alt + F4).

Opät’, pri prvom čı́tanı́ tejto kapitoly môže čitatel’, ktorý sa chce rýchlo oboznámit’ s použı́-
vanı́m programu čast’4.1 preskočit’ a pokračovat’ v čı́tanı́ čast’ou 4.2 na strane 66.

Hlavné menu programu obsahuje tieto položky:

File Edit View Settings Help

Opı́šeme tie položky, ktoré sú potrebné na základné zoznámenie sa s možnost’ami Kpl.
Položky označené hviezdičkou ∗ sa aktivujú len v tom prı́pade, ked’ je otvorený grafický
alebo dátový súbor.

File

New vytvorenie nového projektu

Open Plot File . . . otvorenie súboru s prı́ponou .kpl,

editácia už vytvoreného projektu

Open Data File . . . otvorenie súboru s prı́ponou .dat,

možnost’ výberu desatinnej bodky alebo čiarky

Open Recent desat’ naposledy otvorených projektov

Save∗ uloženie dokumentu pod pôvodným menom

Save As . . . ∗ uloženie dokumentu pod novým menom

Close∗ zatvorenie aktuálneho projektu

Print∗ vytlačenie aktı́vneho grafu

Display Plot∗ zobrazenie grafickej prezentácie alebo obno-

venie zobrazeného grafu

PostScript Output vol’ba orientácie grafického listu na konverziu;

na výšku alebo na šı́rku

PostScript Preview vol’ba orientácie náhl’adu grafu;

na výšku alebo na šı́rku
23V prı́pade, ked’ inštaláciu vykonáte zo zdrojových súborov, musı́ sa cesta na spustenie z Menu nastavit’

manuálne. Autor z vlastnej skúsenosti odporúča spušt’at’ program z pracovnej plochy pomocou vytvorenej
ikonky s odkazom na binárny súbor kpl.
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New Window otvorenie nového pracovného okna programu

Close Window zatvorenie aktuálneho pracovného okna

a ukončenie programu

Quit ukončenie práce s programom Kpl

Edit

Undo∗ zrušı́ posledný vykonaný krok

Redo∗ vráti posledný vykonaný krok

Items . . . jedna z najdôležitejšı́ch položiek, umožňuje vkladat’,

editovat’ a fitovat’ objekty a položky v grafe (napr. funkcie,

polia, splajnové krivky a pod.)

View

Zoom In (Ctrl++) zväčšovanie krokom

Zoom Out (Ctrl+−) zmenšovanie krokom

Zoom . . . nastavenie faktora zväčšenia/zmenšenia (%)

Redisplay∗ (F5) aktuálny dátový alebo grafický súbor sa znova

načı́ta a zobrazı́, aktivuje sa funkcia Autoplot

Reload Periodically nastavenie periodického obnovovania zobra-

zenia, aktivuje sa funkcia Autoplot

Settings

Hide Toolbar skrytie/zobrazenie hlavného menu

Hide Statusbar skrytie/zobrazenie stavovej lišty

Show Function Source zobrazenie zdrojového súboru funkcie

v dialógu vol’by jej parametrov

Autoplot automatické zobrazenie projektu po na-

čı́tanı́ dátového alebo grafického súboru

Add Files (Insert) pridanie nového dátového alebo grafické-

ho súboru do aktuálneho s vykreslenı́m

Calculate PS Bounding Box automatický výpočet hranı́c postscript-

ového okna grafu, bez aktivácie tejto po-

ložky sa vypočı́tajú hranice k niektorému

rozmeru strany (napr. A4 na výšku)

Print PS Output zobrazenie dialógu tlače postscriptového
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súboru po jeho vytvorenı́

Save Absolute Paths do grafického súboru sa uložı́ absolútna

cesta k dátam a knižniciam

Unsaved Changes Warning zobrazenie varovania o neuloženı́ súboru

Save Settings At End uloženie všetkých nastavenı́ aktuálneho

zobrazenia pri ukončenı́ programu

Save Settings uloženie všetkých nastavenı́ aktuálneho

zobrazenia

Configure Shortcuts . . . definovanie vlastných klávesových

skratiek

Configure Toolbars . . . pridanie/odobratie ikoniek do hlavného

menu

Configure Notifications . . . nastavenie hlásenı́ a varovanı́ programu

Configure Kpl . . . niektoré základné implicitné nastavenia

programu

Help

Kpl Handbook otvorenie elektronického manuálu, ked’ je nainštalo-

vaný

Report Bug . . . dialóg na oznamovanie chýb programu autorovi

e-mailovou poštou

About Kpl základné informácie o programe Kpl

About KDE základné informácie o grafickom prostredı́ KDE

4.2 Prı́klady použitia programu

4.2.1 Importovanie dát, ich zobrazenie a úprava grafu

Importovanie dátoveho súboru boxbod.dat

Tak, ako v prı́pade programu QtiPlot, aj program Kpl a jeho funkcionalitu preskúšame dá-
tami z internetovej stránky Národného inštitútu štandardov a technológiı́ Spojených štátov
amerických (NIST, 2006). Stiahnite si dáta z kolekcie pre nelineárnu regresiu s názvom Bo-
xBOD24, ktoré sú zaradené do kategórie s vysokou náročnost’ou na spracovanie. Tabul’ku
uložte do dátového súboru s názvom boxbod.dat.

24 http://www.itl.nist.gov/div898/strd/nls/nls_main.shtml

http://www.itl.nist.gov/div898/strd/nls/nls_main.shtml
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Obrázok 30: Importovanie a zobrazenie dát metódou t’ahaj a pust’

Program Kplmá sı́ce vlastný editor tabuliek, ale s obmedzenými možnost’ami formátovania,
preto si na vytvorenie tabul’ky vyberme radšej nejaký textový ASCII editor (napr. Kate,
gedit, KSpread a pod.). Dátový súbor vytvárame a editujeme v stĺpcovom formáte, a pri
jeho ukladanı́ do pracovného priečinka mu pridávame prı́ponu dat. Symbolom desatinnej
rádovej čiarky môže byt’ desatinná čiarka alebo desatinná bodka a ako oddel’ovač (separátor)
stĺpcov odporúčame použit’ tabulátor (Tab) alebo medzernı́k (Space). Dátový súbor môžeme
importovat’ dvoma spôsobmi:

1. Vyvolanı́m ponúkFile→ Open Data File . . . sa otvorı́ dialógové okno, v ktorom zvolı́me
symbol desatinnej rádovej čiarky a vyhl’adáme na disku súbor na importovanie.

2. Otvorı́me program Kpl a potom nejaký program na spravovanie súborov (napr. Ko-
nqueror alebo Krusader), v ktorom vyhl’adáme súbor, ktorý chceme zobrazit’. Označı́me
ho l’avým klikom myšky a t’ahom ho premiestnime do okna programu Kpl, kde klik
uvol’nı́me (metóda Drag and Drop), pozri obrázok 30.

„Surový“ graf z obrázku 30 budeme upravovat’ vyvolanı́m položky Items . . . Možeme ju
aktivovat’ dvoma spôsobmi, pravým klikom myši do prázdmeho pol’a v okne programu
(mimo pol’a grafu) a z kontextového menu vyberieme žiadanú položku alebo vyvolanı́m
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ponúk Edit → Items . . . , pozri obrázok 31.

Obrázok 31: Pracovné okno položky Items . . .

Po pridanı́ legendy (výberom New), označenı́ a zmene modulov osı́ (pozri na strane 74),
zmene zafarbenia a symbolov dátových bodov (označenı́m a výberom Edit) dostaneme
takýto výsledok:

Obrázok 32: Upravený graf z obrázku 30

4.2.2 Nelineárna regresia pre súbor boxbod.dat

Tak, ako v prı́pade programu QtiPlot aproximujme dáta znázornené v grafe na obrázku 32
exponenciálnou závislost’ou v tvare

y = a[1− exp(−bx)],

ktorá je podl’a (NIST, 2006) modelovou funkciou pre tieto dáta. Program implicitne takúto
funkciu neponúka, ale môžeme ju napı́sat’ ako skript v programovacom jazyku C, napr.
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boxbod.c, a skompilovanı́m vytvorit’ knižnicu (modul) boxbod.so.

Postup je nasledovný: v textovom editore napı́šeme naprı́klad takéto funkcie v jazyku C.
Prvá boxbod 1 bude na vykreslenie fitovanej čiary do grafu, druhá boxbod 2 na iteráciu:

/****************************************************************/

/* boxbod.c 2D functions for Kpl */

/* Copyright (C) 2006 by Ladislav Sevcovic */

/* <ladislav.sevcovic@tuke.sk> */

/* Released under the GPL; see file LICENSE for details. */

/* */

/* Use the following command to compile the C function */

/* and create a shared library: */

/* gcc -Wall -shared -fPIC -o boxbod.so boxbod.c -lm */

/* Do this in a X terminal windows (shell). */

/* At the X terminal type: nm boxbod.so>boxbod.def */

/* */

/* exponential(x, p) calculates of exponential */

/* Returns: p[0] * (1 - exp(-p[1] * x)) */

/****************************************************************/

#include <math.h>

/****************************************************************/

double boxbod_1(double x, const double* p)

{

return(p[0]*(1-exp(-p[1]*x)));

}

/****************************************************************/

double boxbod_2(double x, const double* p)

{

int i;

double f;

f = p[0];

for (i = 1; i < 3; i += 1)

f == p[i] * (1 - exp(- p[i + 1] * x));

return f;

}

/****************************************************************/

Súbor uložı́me do pracovného priečinka pod menom boxbod.c a do prı́kazového riadka
v okne X terminálu najprv napı́šeme25

gcc -Wall -shared -fPIC -o boxbod.so boxbod.c -lm

a stlačnı́m klávesu Enter prebehne kompilácia nášho skriptu do binárnej knižnice boxbod.so.
Potom napı́šeme

25Súčast’ou OS GNU/Linux je aj kompilátor gcc jazyka C a rad d’alšı́ch programátorských nástrojov. Program
nm vytlačı́ tabul’ku symbolov (zoznam názvov) v abecednom poradı́ pre jeden alebo viac objektových súborov.
Výstup obsahuje pre každý symbol meno, hodnotu, typ, vel’kost’ a pod.
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nm boxbod.so>boxbod.def

a opätovným odoslanı́m sa vytvorı́ tabul’ka symbolov. Dva skompilované súbory boxbod.so

a boxbod.def použijeme na fitovanie, môžeme ich teda presunút’ do pracovného priečinka,
v ktorom máme ostatné súbory s dátami pre Kpl alebo do osobitného podpriečinka, v kto-
rom budú len knižnice (aj budúce). Teraz už môžeme začat’ s fitovanı́m dát, v okne položky

Obrázok 33: Okno položky Function na vykreslenie fitovanej funkcie

Items (obrázok 31) klikneme na ponuku New a potom na ponuku Function (obrázok 33).
Vyhl’adáme si našu knižnicu boxbod.so a z nej vyberieme funkciu boxbod 1, doplnı́me xmax
na 10, vyberieme symbol, vel’kost’ a farbu fitovacej čiary v grafe a výber ukončı́me potvr-
denı́m Apply a potom OK. Prejdeme opät’ do okna Items, kde klikneme na novovytvorenú
položku Function a potom na okienko Fit, čı́m sa nám otvorı́ okno Parameter fit, pozri ob-
rázok 34. Zaškrtneme l’avé okienka × pre parametre p0 a p1 a do pravých vpı́šeme ich
štartovacie hodnoty, pre p0=100 a pre p1=0.75. Fitovanie bude nelineárne, preto zaškrt-
neme aj okienko × Nonlinear fit. Kliknutı́m do položky Model sa otvorı́ okno Error model
function, v ktorom opät’ vyhl’adáme knižnicu boxbod.so a z nej tentoraz vyberieme funkciu
boxbod 2, ako argument zvolı́me ycolumn. Kliknutı́m na položku Edit zadáme štartovacie pa-
rametre iteračného procesu (iteračný proces sa ukončı́ dobre aj so začiatočnými hodnotami
p0=1 a p1=1). Výsledné parametre fitovanej funkcie y=p[0]*(1-exp(-p[1]*x)) sa vpı́šu do
prı́slušných okienok parametrov (obrázok 35). Kliknutı́m na položku Apply sa vysledok fi-
tovania zobrazı́ v grafe (obrázok 36). Prácu s fitovanı́m ukončı́me kliknutı́m na položku OK.
Do grafu vložı́me legendu, názvy osı́ a tak d’alej (pozri Kapitolu 5).
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Obrázok 34: Výrez okna položky Parameter fit so
štartovacı́mi parametrami iteračného procesu fito-
vania

Obrázok 35: Výrez okna položky Parameter fit
s výsledkami iteračného procesu fitovania

Obrázok 36: Výsledný graf s fitovanou krivkou pre dáta boxbod.dat
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4.2.3 Lineárna regresia funkciou y = ax

Podobne ako v programe QtiPlot aj v tejto časti krátko opı́šeme postup lineárnej regresie
modelovou funkciou

y = ax,

ktorú použijeme na fitovanie dát NoInt1 z kolekcie pre lineárnu regresiu už spomenutého
inštitútu NIST (2006)26, aby sme mohli výsledky oboch programov porovnat’.

Aj v tomto prı́pade tabul’ku dát môžeme doplnit’ bodom (0, 0), aby sme zı́skali výsledné gra-
fické zobrazenie v takom tvare, aké je na WWW stránke inštitútu NIST. Úpravu prevedieme
takto: z ponuky Items označı́me položku Array a klikneme na okno Edit. Otvorı́ sa nám nové
okno, v ktorom zaškrtneme okienko × Internal data a potom vyberieme ponuku Edit. Do
odsadeného prvého riadka zapı́šeme tri nuly s medzerami 0 0 0, upravu potvrdı́me klikom
na Apply a editor zatvorı́me klikom na OK.

Zı́skanie optimálneho parametra a bude jednoduchššie ako v predošlom prı́pade, lebo mô-
žeme na to použit’ zabudovanú funkciu programu Kpl (samozrejme, môžeme si napı́sat’ aj
vlastnú). Postup bude podobný, ako pri nelineárnej regresii, s tým rozdielom, že na fitovanie
použijeme knižnicu fkt.so, z ktorej vyberieme funkciu polynom.

Úprave hodnôt v tabul’ke noint1.dat sa však môžeme vyhnút’. Na rozdiel od postupu v
prı́pade úpravy v programe QtiPlot (pozri na strane 53) však nemusı́me upravovat’ žiadnu
tabul’ku, lebo programKpl údaje na vykreslenie krivky fitovanej funkcie neukladá do osobit-
nej tabul’ky. Vyvolanı́m okna položky Items označı́me v nej položku Function a klikneme na
okno Fit. Otvorı́ sa nám okno Parameter fit, v ktorom z l’avých okienok pre parametre zaškrt-
neme len okienko pre parameter × p1, do pravého okienka vpı́šeme štartovaciu hodnotu
p1=1 a okienko Nonlinear fit zostane nezaškrtnuté, pozri obrázok 37. Výsledky vidı́me na
obrázku 38 a na obrázku 39.

Vytvorené grafy upravené podl’a odporúčanı́ z kapitoly 5 môžeme uložit’vo formáte *.ps

alebo *.eps na d’alšie spracovanie (z hlavného menu File → PostScript Output).

26 http://www.itl.nist.gov/div898/strd/lls/lls.shtml

http://www.itl.nist.gov/div898/strd/lls/lls.shtml
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Obrázok 37: Výrez okna položky Parameter fit so
štartovacı́m parametrom

Obrázok 38: Výrez okna položky Parameter fit
s výsledkom iteračného procesu fitovania

Obrázok 39: Výsledný graf s fitovanou krivkou pre dáta noint1.dat



Jeden obrázok má hodnotu tisı́c slov.

STARÉ ČÍNSKE PRÍSLOVIE

5 Niekol’ko pravidiel na tvorbu grafov

Z precı́zne vyhotoveného grafu nameranej fyzikálnej závislosti dvoch veličı́n sa dajú s dosta-
točnou mierou presnosti určit’charakteristiky funkcie. Je možné napr. určit’polohu extrémov,
inflexných bodov, pri lineárnej závislosti odčı́tat’ z grafu smernicu priamky atd’. Graf je vždy
názornejšı́ ako tabul’ka, tabul’ka je však vždy presnejšia. Grafu dávame prednost’, ked’chceme
ukázat’ priebeh, tendenciu, štruktúru alebo obrazec.

Dôvod je jednoduchý a spočı́va v rýchlom, pohodlnom a názornom prijı́manı́ obrazovej
informácie človekom. Dalo by sa povedat’, že graf slúži na rýchlu kvalitatı́vnu orientá-
ciu v nameranej závislosti a ak nás zaujı́majú podrobnejšie kvantitatı́vne údaje, z pamäte
počı́tača si necháme zobrazit’ tabul’ku funkcie resp. analytický predpis, interpolačnú for-
mulu atd’. Z dôvodu názornosti je grafické zobrazenie funkciı́ vel’mi časté i vo fyzikálnej
literatúre a takmer každá nameraná závislost’ je reprezentovaná grafom. Na zhotovenie gra-
fov nie sú jednoznačné pravidlá a v každom odbore sú trocha odlišné zvyklosti určené napr.
tradı́ciou, typografickými možnost’ami časopisov a pod. Na zrozumitel’ný a prehl’adný graf
budú kladené tieto požiadavky:

1. Modul stupnice grafu zvolı́me tak, aby graf bol dostatočne vel’ký, t. j. interval nezávisle
premennej má byt’ zobrazený na „vodorovnej“ osi viac ako na dvoch tretinách „vo-
dorovného“ rozmeru grafu a analogicky interval na „zvislej“ osi. Pod pojmom modul
stupnice rozumieme podiel intervalu nameraných (v prı́pade extrapolácie potrebných)
hodnôt fyzikálnej veličiny k dĺžke osi, povedzme v mm, na ktorú chceme interval
zobrazit’. Napr. obrázok 40 znázorňuje graf, v ktorom ked’ zvolı́me dĺžky osı́ 120 mm
bude modul vodorovnej stupnice M1 = (90 V− 40 V)/120 mm = 0,4166 V/mm a zvis-
lej stupnice M2 = (7 A− 1 A)/120 mm = 0,05 A/mm.

2. Osi vyznačı́me plnou úsečkou a označı́me jednotkami v okruhlej zátvorke, v ktorých
je fyzikálna veličina vynášaná. Osi nekalibrujeme hodnotami, ktoré sme namerali, ale
takými hodnotami, medzi ktorými je l’ahká interpolácia.

3. V každom prı́pade do grafu vhodnými symbolmi vyznačı́me namerané hodnoty. Ak je
v jednom grafe viac priebehov alebo na jednom papieri viac grafov, pre rôzne priebehy
volı́me rôzne symboly na označenie nameraných hodnôt (napr. plné body pre jeden
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graf, trojuholnı́ky pre d’alšı́ atd’.). Od nameraných hodnôt nevedieme na osi žiadne
čiary (pozri obrázok 40)27.

4. Každý graf opı́šeme stručným komentárom, aby bolo jasné, akú závislost’ graf vyjad-
ruje.

Voltampérovácharakteristika

PrúdI
(A)

1
2
3
4
5
6
7

NapätieU(V)405060708090

vláknoAvláknoB

Obrázok 40: Prı́klad nakresleného gra-
fu, ktorý znázorňuje voltampérovú (VA)
charakteristiku dvoch kovových vlákien

Meranie je zat’ažené chybami a po vynesenı́ name-
raných hodnôt zistı́me, že body sú „rozhádzané“.
Treba sa rozhodnút’ ako preložit’ cez namerané body
čiaru. Ak sme meranie vyhodnotili metódou najmen-
šı́ch štvorcov a určili parametre z rovnı́c (35), potom
pretabelujeme funkciu F∗(x, p̂1, . . . , p̂k) (Kapitola 2)
a túto funkciu vynesieme do grafu. Zı́skame tak jedno-
značne určenú (v zmysle vyrovnávajúceho počtu vy-
rovnávajúcu) hladkú čiaru. Napr. pri lineárnej závis-
losti y = a + bx zistı́me, že táto priamka neprechádza
všetkými nameranými bodmi, ale približne polovica
bodov je nad a približne polovica bodov pod priam-
kou. V ostatných prı́padoch, ked’ nemôžeme použit’
vyrovnávajúci počet, nemáme k dispozı́cii ani opod-
statnený návod ako preložit’ čiaru cez namerané body,
tu záležı́ vel’a od skúsenosti experimentátora. Oblasti
zat’ažené vel’kými chybami sa premerajú znova, hus-

tejšie resp. inými metódami. Čiaru, ktorú narysujeme, sa snažı́me viest’ tak, aby bola vyrov-
naná, t. j. nemala fyzikálne neopodstatnené skoky, zalomenia a extrémy, aby bola dostatočne
hladká, aby približne rovnaký počet nameraných bodov bol nad i pod čiarou a súčet štvor-
cov nameraných hodnôt od čiary by mal byt’ čo najmenšı́. Majme stále na pamäti, že čiara
v takomto grafe má viac-menej kvalitatı́vny význam.

Pri dôslednejšı́ch experimentoch sa merania v každom bode opakujú za rovnakých podmie-
nok a každý bod v grafe je spracovaný vyššie opı́sanými metódami pre opakované merania.
V takýchto prı́padoch sa zvykne okrem najpravdepodobnejšej hodnoty (nameranej hodnoty)
vyznačit’ v grafoch aj štandardná neistota pre každý bod zvlášt’.

Zhrnutie

• Obrys grafu nesmie byt’ nikdy nakreslený hrubšou čiarou, ako čiary v ploche grafu,
taktiež úsečky, ktoré vyznačujú chyby meraných hodnôt, nemôžu byt’ výraznejšie ako
vlastné krivky alebo priamky. Kóty na osiach musia udávat’ l’ahko delitel’né hodnoty.

27Tento obrázok bol vytvorený programom QtiPlot, uložený vo formáte EPS a potom programom epstopdf
konvertovaný do formátu PDF.
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• Do grafu umiestňujeme čo najviac informáciı́, menej do legendy grafu.

• Dbáme na prehl’adnost’ grafu a čitatel’nost’ pı́sma v grafe. Na popis osı́ sa častejšie
použı́vajú verzálky (vel’ké pı́smená), pre informácie vpı́sané do grafu mı́nusky (malé
pı́smená) pı́sma z rodiny Sans Serif.

• Osi grafu nemajú byt’ dlhšie, ako určuje výskyt pokusných bodov, v grafe teda nemajú
byt’ prázdne plochy. Osi nemusia začı́nat’ nulovou hodnotou.

• Vhodným tvarom grafu je obvykle štvorec alebo obdĺžnik (na ležato). Uzavretie grafu
do štvorca alebo obdĺžnika zjednodušuje určenie hodnôt jednotlivých bodov. Kóty
môžeme na protil’ahlých osiach opakovat’ bez doplnenia čı́sel.

• Poznáme šest’ hlavných druhov (typov) grafov:

– bodový garf (scattergram),

– čiarový (priebehový) graf (line graph),

– stĺpcový graf (bar graph),

– histogram (vlastne stĺpcový graf so stĺpcami umiestnenými tesne vedl’a seba),

– koláčový diagram (pie graph),

– trojrozmerný graf (three-dimensional graph).

• Dbáme na to, aby v bodovom a čiarovom grafe boli symboly a charakter jednotlivých
čiar l’ahko odlı́šitel’ný aj pri zmenšenı́ tlače. V grafoch pripravovaných na počı́tači
je potrebné správne zadat’ požadované vzdialenosti a popis kót, zvolit’ len výrazné
symboly, snažit’ sa všetko vyjadrit’ jednou farbou a pod.



Záver

Ked’ hovorı́me o prı́prave experimentálnych dát na prezentáciu a d’alšie vyhodnocovanie
s použitı́m osobného počı́tača, potom samozrejme musı́me venovat’ náležitú pozornost’
nielen samotným programom, ale aj metódam a postupom spracovania dát.

Opis dvoch známych produktov z tejto oblasti nám v základoch objasnil ich všeobecné aj
niektoré špecifické vlastnosti. Domnievame sa, že prvoradým prı́nosom štúdia tejto prı́ručky
sú základné informácie o ovládanı́ opı́saných programov a zı́skane poznatky, ako tvorit’
grafické výstupy matematických funkciı́ a spracovaných experimentálnych dát na d’alšiu
kvalitatı́vnu analýzu prı́padne prezentáciu.

Tabuľka 2: Porovnanie parametrov fitovania pre referenčné dáta NIST s hodnotami zı́skanými z programov
QtiPlot a Kpl, a a b sú odhadované parametre, σa a σb sú štandardné neistoty (smerodajné odchýlky) odhado-
vaných parametrov, RSD je reziduálna štandardná odchýlka (Residual Standard Deviation), SQ je suma štvorcov
odchýlok (Sum of Squres), Chi^2/doF je redukovaná hodnota χ2 a doF znamená Degrees of Freedom čiže n− k

NIST QtiPlot Kpl

NoInt1

a 2,074 38 2,074 38 2,074 38

σa 0,016 53 0,004 63 0,016 53

n−k=10 RSD=3,567 53 Chi^2/doF=12,7273 chi-square=127,3

SQ=127,272 72 Chi^2=127,273

BoxBOD

a 213,809 41 213,809 53 213,809 00

σa 12,354 52 0,722 99 12,354 50

b 0,547 24 0,547 24 0,547 24

n−k=4 σb 0,104 56 0,006 12 0,104 56

RSD=17,088 07 Chi^2/doF=292,002 chi-square=1168,008 876

SQ=1 168,088 77 Chi^2=1 168,008

Podklady k tejto prı́ručke vznikali v priebehu práce autora na projekte KEGA Využitie
open source softvéru vo výučbe na vysokých školách. Ciel’om nebolo vykonanie nejakej recenzie,
na základe ktorej by sa dali oba programy rigorózne ohodnotit’. Každý z prezentovaných
programov má svoje prednosti aj nedostatky (stále sa vyvı́jajú a vylepšujú). Porovnanie
výsledkov uvedených v tabul’ke 2 má čitatel’ovi oboznámenému s funkčnost’ou a hlavnými
možnost’ami programov ul’ahčit’ rozhodovanie sa, ktorému z nich dá prednost’ pri výbere.
Pozorný čitatel’, ktorý vyskúšal program QtiPlot podl’a nášho postupu (alebo stačı́ nazriet’
do tabul’ky 2) si isto všimne, že hodnoty štandardných neistôt, ktoré program vypočı́ta sú
rádovo rozdielne od údajov inštitútu NIST. Je to spôsobené tým, že program QtiPlot počı́ta
redukovanú hodnotu χ2 (pozri vzt’ah 54) označenú ako Chi^2/doF, kde doF znamená Degrees
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of Freedom čiže n− k a štandardná neistota parametra je určená podl’a vzt’ahu

σqti =

√
(cov)ii

Chiˆ2/doF
. (70)

Na WWW stránke inštitútu NIST sa však dočı́tame, že ich údaj štandardnej neistoty para-
metra sa počı́ta podl’a vzt’ahu

σnist =
√

(cov)ii , (71)

kde (cov)ii je v oboch prı́padoch kovariančná matica parametrov regresie, pozri napr. v prá-
cach (PRESS ET AL., 1992; KUDRACIK, 1999). Pri rovnosti kovariančných matı́c, potom súvis
oboch údajov môžeme vyjadrit’ vzt’ahom

σnist = σqti
√

Chiˆ2/doF. (72)

Ked’ teda potrebujeme výsledok numerického spracovania dát regresiou programom QtiP-
lot uviest’ so štandardnou neistotou hl’adaných parametrov, musı́me tento „nedostatok“
výpočtu programu korigovat’ použitı́m vzt’ahu (72), štandardná neistota parametra regresie
sa uvádza v takom tvare, ako na WWW stránke inštitútu NIST.

Mali sme možnost’ pracovat’ aj s programomOrigin 6.128, ktorému sa opisovaná verziaQtiP-
lot 0.8.5 svojı́mi možnost’ami a ponukou najviac približuje. Čo sa týka rozdielu z pohl’adu
bežného použı́vatel’a, QtiPlot má menšı́ výber formátov do grafického výstupu. Nepokla-
dáme to ale za taký vel’ký nedostatok. Origin 6.1 má však lepšie vypracované možnosti
napr. ponuky Analysis v grafickom móde a rozšı́renejšiu ponuku modulu Non-Linear Curve
Fit. . . , lepšiu 3D grafiku a iné, ktoré nám však pri štandardnej práci s programom nebudú
chýbat’. Ako sme už spomenuli, QtiPlot je vo vývoji a neustále sa vylepšuje. V prı́pade
uvádzania štandardných neistôt parametrov regresie program Origin ich uvádza v takej
forme, ako inštitút NIST. Tento rozdiel medzi programami je snád’ jediný vážny nedostatok,
s ktorým sme sa počas práce s programom QtiPlot stretli.

Záverom ešte jeden postreh, zo skúsenosti odporúčame otvárat’ uložené projekty programu
Kpl klikom29 na súbor s prı́ponou plo. Pri otváranı́ projektu cez hlavné menu File → Open
Plot File . . . sa grafy v niektorých prı́padoch nezobrazia presne tak, ako boli uložené (trochu
sa posunú vložené texty, legendy a pod.). Tieto nedostatky sú sı́ce formálneho charakteru,
lebo graf l’ahko upravı́te do pôvodneho stavu (ak si ho ešte s odstupom času pamätáte :-),
ale dokážu zneprı́jemnit’ pôžitok z už vykonanej práce.

Učenie a bádatel’ská práca je zaujı́mavá, často aj vzrušujúca činnost’. Ked’ju vykonávame deň
čo deň tvorivo s láskou aj ako zál’ubu, prináša nám osobnú radost’ i duševné uspokojenie.
Nevyhneme sa však pritom ani rutinnej a mechanickej práci, ktorú môže počı́tač v značnej
miere ul’ahčit’.

28Komerčný program, cena aktuálnej verzie Origin 7.5 je asi 19 000,– SKK bez DPH.
29Alebo dvojklikom, podl’a distribúcie a grafického prostredia OS GNU/Linux.
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Chyby analogových meracı́ch prı́strojov

Pre praktickú potrebu bola zvolená a normovaná charakteristika nazývaná trieda pres-
nosti δTP. Trieda presnosti zahrňa všetky chyby samotného prı́stroja a definuje tak medznú
(maximálnu, dovolenú) relatı́vnu chybu v celom meracom rozsahu prı́stroja

δTP =
|∆max|

Xmr
100 (%), (73)

kde ∆max je medzná (maximálna) absulútna chyba prı́stroja a Xmr je najväčšia hodnota
meracieho rozsahu. Meracı́ rozsah je čast’ stupnice meracieho prı́stroja, na ktorej je možné
merat’ s predpı́sanou presnost’ou. Najväčšia hodnota meracieho rozsahu Xmr je určená

• hornou hranicou meracieho rozsahu (ked’ je dolná hranica nula),

• súčtom oboch medzných hranı́c (ked’ je nula uprostred stupnice),

• rozdielom hornej a dolnej hranice (ked’ je potlačená nula na stupnici).

Ked’má prı́stroj určitú tiedu presnosti je tým definovaná jeho maximálna dovolená relatı́vna
chyba vyjadrená v % najväčšej hodnoty meracieho rozsahu. Trieda presnosti je uvedená
na čı́selnı́ku každého analogového meracieho prı́stroja. Maximálnu absolútnu chybu prı́stroja
možeme vyjadrit’ vzt’ahom

∆max = ±Xmr

100
δTP. (74)

Relatı́vna chyba meraného údaja je

δrel = ±∆max

Xmh
100 = ±δTP

Xmr

Xmh
(%),

kde Xmh je nameraná hodnota. Z posledného vzt’ahu je vidiet’, že čı́m menšia je meraná
hodnota (čı́m menšia je výchylka prı́stroja), tým väčšia bude relatı́vna chyba merania. Z toho
vyplýva, že pri meranı́ analogovými meracı́mi prı́strojmi musı́me volit’ taký rozsah prı́stroja,
aby jeho výchylka bola čo najväčšia!

Prı́klad A

Analogovým voltmetrom s triedou presnosti δTP = 1 sme namerali na rozsahu Xmr = 60 V
napätia 58 V a 5 V.
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Absolútna chyba je pri všetkých meraniach rovnaká a je daná triedou presnosti použitého
voltmetra

∆max = ±Xmr

100
δTP = ± 60

100
1 = ±0,6 V.

To znamená, že prı́stroj meria s presnost’ou ±0,6 V na celej stupnici pri meranı́ napätia 58 V
aj pri meranı́ napätia 5 V. Vel’kosti relatı́vnych chýb údajov budú

δrel = ±δTP
Xmr

Xmh
= ±1

60
58

= ±1,03 %,

δrel = ±δTP
Xmr

Xmh
= ±1

60
5

= ±12 %.

Vidiet’, že so znižovanı́m výchylky relatı́vna chyba údaja rýchle rastie, jej závislost’ od vý-
chylky je hyperbolická!

Obrázok 41: Na obrázku vidı́me prı́klady zobrazenia hodnoty prúdu a napätia analogovými meracı́mi
prı́strojmi s triedou presnosti 2,0. Maximálna absolútna chyba hodnoty merania bola vypočı́taná pomocou
vzt’ahu (74)

Chyby čı́slicových meracı́ch prı́strojov

Čı́slicové (digitálne meracie prı́stroje) merajú pomerne dobre len jednosmerné napätia a prúdy,
ostatné veličiny s niekol’konásobne väčšiou chybou ako presné analogové (ručičkové) me-
racie prı́stroje, pretože sa u týchto prı́strojov všetky merané veličiny prevádzajú pomocou
usmerňovača na jednosmerné napätie. Usmernené napätie sa d’alej digitalizuje pomocou
analogovo-čı́slicového prevodnı́ka (AD). AD prevodnı́ky vnášajú do merania d’alšie chyby.
Nemá teda zmysel overovat’ triedu presnosti analogového meracieho prı́stroja pomocou
bežného vreckového multimetra!

Väčšina výrobcov čı́slicových prı́strojov uvádza presnost’ prı́stroja (tzv. základnú chybu)
v tvare δčmp =±(δmh+d), niektorı́ v tvare δčmp =±(δmh+δmr), kde
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δmh je chyba z nameranej hodnoty, býva vyjadrená v % a je v celom meracom rozsahu
konštantná, niekedy sa za ňu pripisuje značka rdg (reading–čı́tanie),

δmr je chyba z meracieho rozsahu, nemôžeme ju však jednoducho sčı́tat’ s chybou z name-
ranej hodnoty δmh, ale ju musı́me prepočı́tat’na vel’kost’nameranej hodnoty

(
δmr

Xmr
Xmh

)
;

niekedy sa za ňu pripisuje značka FS (full scale–plný rozsah),

d je chyba udaná z počtu jednotiek (digitov) posledného miesta displeja. Jej prepočet na
chybu z meracieho rozsahu závisı́ od počtu zobrazovaných miest displeja. Prepočet na
percentuálnu chybu z meracieho rozsahu je rovný δmr = d

max. počet indikovaných jednotiek 100 (%).

Celková relatı́vna chyba čı́slicového meracieho prı́stroja je pri meranı́ vyjadrená vzt’ahom

δrel = ±
(

δmh + δmr
Xmr

Xmh

)
(%), (75)

kde Xmr je hodnota meracieho rozsahu a Xmh je nameraná hodnota.

Súčasné čı́slicové meracie prı́stroje majú automatické prepı́nanie rozsahov, aby bola pri me-
ranı́ vždy dosiahnutá maximálna presnost’. Podl’a maximálneho počtu zobrazených miest
zistı́me, na ktorom rozsahu multimeter práve meria. Napr. multimeter s maximálnou hod-
notou 3 999 prepı́na pri meranı́ automaticky rozsahy 400 mV – 4 V – 40 V – 400 V. Multimeter
s maximálnou hodnotou 1 999 prepı́na pri meranı́ automaticky rozsahy 200 mV – 2 V – 20 V
– 200 V. Prepı́nanie rozsahov na meranie ostatných veličı́n prebieha podobne. Samozrejme
chyby každého multimetra pre jednotlivé rozsahy najdete v návode na použı́vanie meracieho
prı́stroja.

Prı́klad B

Čı́slicový voltmeter má na rozsahu 40 V základnú chybu ±(0,9 rdg+0,1FS). Máme zistit’,
relatı́vnu chybu nameraných napätı́ U1 =10 V a U2 =28 V na tomto rozsahu.

δrel(U1) = ±
(

δmh + δmr
Xmr

U1

)
= ±

(
0,9 + 0,1

40
10

)
= ±1,3 %,

δrel(U2) = ±
(

δmh + δmr
Xmr

U2

)
= ±

(
0,9 + 0,1

40
28

)
= ±1,04 %.

Prı́klad C

Chyba čı́slicového multimetra s 3 1
2 miestným displejom (maximálna indikovaná hodnota

je 1 999) je pre meranie striedavého prúdu udaná v tvare δmh =±(1,5 % + 7 dibit)30. Máme
zistit’ vel’kost’ relatı́vnej chyby multimetra, ked’ meriame na rozsahu 40 A prúd 6 A.

30 dibit je kombinácia (skupina) dvoch binárnych čı́siel (digitov) do jednej alebo štyroch kombináciı́. Štyri
možné stavy pre dibit sú 00, 01, 10 a 11.
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Maximálny počet indikovaných jednotiek je 2 000.

δmr =
d

max. počet indikovaných jednotiek
100 =

7
2 000

100 = 0,35 %.

Celková chyba má tvar ±(1,5 % + 0,35FS).

Relatı́vnu chybu určı́me zo vzt’ahu

δI = ±
(

δmh + δmr
Xmr

Xmh

)
= ±

(
1,5 + 0,35

40
6

)
= 3,83 %.
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